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1.0 QUALITY ASSURANCE

1.1 UNIT DESCRIPTION

The Forensic Biology Unit is comprised of Criminalists, a DNA Technical Manager, a CODIS Administrator, a
Laboratory Technician, and two Supervising Criminalists. The unit is generally staffed from 0700-1700hrs
Monday through Friday.

The Forensic Biology laboratory is divided into three distinct arcas on the 6thdlooriof the SDPD headquarters
building: the main laboratory area which is used for the purposes of screefiing items of evidence and the DNA
extraction process; a room dedicated to PCR setup; and a separate area dedicated to the preparation and analysis
of amplified DNA.

1.2 UNIT FUNCTIONS

The Forensic Biology Unit aims to provide analysis on all’reasonablérequests from any investigative units of the

San Diego Police Department using the most current technologies available.

The Forensic Biology Unit’s primary dutiesrare to analyze items of physical evidence to locate and identify

biological material, and perform DNAfanalysis on, thabbiological material.
The biological materials that the Unit can presimptively identify, or confirm the presence of, are blood, semen,
and saliva. DNA analysis may,be pérformed on all of these materials as well as hair, bone, and other body fluids

or tissues.

The DNA testing capabilities of the Forensic Biology Unit include both autosomal and Y-chromosome STR DNA
testing.

Additional duties performed by the Forensic Biology Unit include the validation and implementation of new

technologies, courtroom testimony, and crime scene reconstruction.
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1.3 PERSONNEL AND JOB DESCRIPTIONS

1.3.1 SUPERVISING CRIMINALIST

The Supervising Criminalist of the Forensic Biology Unit will oversee the Forensic Biology Unit and analysts.

The responsibilities will include assigning casework, interacting with attorneys and detectives to determine

case priorities, reviewing the work of all assigned analysts, and monitoring the overall job performance of

analysts.

Duties and responsibilities: (The duties of Supervising Criminalist and DNA Technical Manager may be

assigned to a single person.)

A.

Establishes casework priorities based on negotiations and discussions with investigators and district
attorneys.

Assigns casework to analysts.
Reviews reports and examines case notes.
Reviews and evaluates the performance of subordinates.

Works with the DNA Technical Manager topeview and establish Unit specific policies and analytical
procedures when appropriate.

Interviews and hire§ new employees.

Trains the néwemployeesion department policies and procedures.
Works with thetDNA Technical Manager to coordinate analyst training.
Keeps track of workload statistics.

Prepares budget requests.

K. Holds Unit meetings to disseminate department, laboratory, or unit specific information.
L. Prepares reports as required by the Crime Laboratory Manager.
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1.3.2 DNA TECHNICAL MANAGER

The DNA Technical Manager will oversee the technical operation of the DNA Laboratory as outlined by the
FBI Director’s Quality Assurance Standards for DNA Testing Laboratories. The DNA Technical Manager will

evaluate new technologies, resolve technical problems, assess and design training programs, and ensure the

unit adheres to all quality assurance guidelines. The DNA Technical Manager is authorized to shut down the

DNA laboratory should a serious technical problem develop.

Duties and responsibilities:

A.

Responsible for the technical operation of the laboratory as outlined imsthe FBI Director’s Quality
Assurance Standards for DNA Testing Laboratories.

Reviewing, revising and approving any DNA-related technical policy omprocedure prior to final
issuance by the Quality Manager.

Approving and overseeing training of new employees (when applicable) in DNA analytical procedures,
including completion of training documentation.

Overseeing, reviewing and approving DNAimethod, validation, including completion of validation
documentation, prior to final approval by QA Manager.

Working with the Quality Mapager on anyyCorrective Action reports involving a DNA technical issue,
and reviewing and signing off on those @orrective Action reports.

Acting as a technical yéference forithe’Quality Manager.
Performing some technical reviews of DNA case files.

Acting as a mediator when necessary in the technical review of DNA casework in the Forensic Biology
Unit.

Providing technical consultation as needed to the members of the Forensic Biology Unit.

Working with Supervising Criminalists and Quality Manager to ensure compliance of the DNA analysts
with QA and unit policies and procedures.

K. Reviewing the DNA proficiency tests completed by the Forensic Biology Unit.
L. Conducting casework analysis.
M. Prepares reports as required by the Crime Laboratory Manager and Assistant Crime Laboratory
Manager.
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1.3.3 CODIS ADMINISTRATOR

The CODIS Administrator is responsible for the security and integrity of the local CODIS network, the
CODIS software, and the data within the local database. The CODIS Administrator ensures the data within
the local CODIS database is in compliance with NDIS guidelines. The CODIS administrator is authorized to
terminate an analyst’s or the laboratory’s participation in CODIS until the reliability and security of the
computer data can be assured if an issue with the data is identified. If the CODIS Administrator determines at
any point that the CODIS network, software, or entered data has been compromised, the DNA Technical
Manager will be immediately notified. The DNA Technical Manager and CODIS Administrator will

determine the proper course of action to reinitiate participation in CODIS for the analyst(s) or laboratory.
Duties and responsibilities:

A. Oversees the entering of DNA profiles from casework into thie localsdatabase.

B. Ensures that DNA profiles are searched against the local CODIS database.

C. Uploads data to the California CODIS database:

D. Downloads and searches DNA profiles from the CJIS WAN website.

E. Performs upgrades to the CODISfsoftware with the assistance of the CODIS Help Desk.

F. Ensures that a backup is maintained for the information in the local database.

G. Schedules and documents the'y@arly-training of analysts in the operation of CODIS software.

H. Disseminates CODISlinformation to the rest of the Forensic Biology Unit.

1.3.4 CRIMINALIST (I AND II)

The job descriptions for Criminalist I and II are similar except that Criminalist II duties may be more extensive
and Criminalist IT analysts are expected to work more independently. In addition to the normal educational
requirements of the Criminalist position, DNA Criminalists must complete college-level classes in

Biochemistry, Molecular Biology, Genetics, and Statistics and/or Population Biology.
Criminalist I and II’s primary duties involve locating and identifying biological material on items of physical
evidence and performing DNA analysis. Analysts are required to document all exams, tests, observations,

results, summarize the findings in a written report, and if necessary, testify in courts of law.

Duties and responsibilities:
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A. Receives, inventories, screens, and preserves items of physical evidence.
B. Locates and identifies biological material.

C. Conducts DNA analysis to determine possible associations between the evidence and any reference
samples provided.

D. Writes reports summarizing the findings and provide expert testimony in court.

E. Remains technically current and knowledgeable in appropriate analytical methods.

F. Participates in the evaluation and validation of new technologies or methodologies.

G. Participates in any special projects as assigned by the Superyising Criminalist or Laboratory Manager.

H. Informs the Supervising Criminalist or DNA Technical Manager of problems that develop at any stage of a
case.

. Uses the technical manual, unit policies manuahand gencral quality assurance manual to deal with any
procedural question or analytical method.
1.3.5 LABORATORY TECHNICIAN

The laboratory technician fanctions as a support position for the Forensic Biology Unit. Duties include
ordering supplies, calibrating instruments, monitoring operating temperature of equipment, performing
routine maintenancéof equipment, and cleaning the unit on a weekly schedule. The laboratory technician
maintains a database ‘of all.chémicals ordered by the Unit. If the position of Laboratory Technician is unfilled
the duties and responsibilities will be shared among current employees. Certain functions described above may
be performed by volunteers or interns but only under the direct supervision of the laboratory technician or

other qualified analyst.
Duties and responsibilities:

A.  Checks the calibration of instruments such as pipettes, thermal cyclers, and balances.
B. Orders chemicals and supplies for Forensic Biology
C. Maintains an accurate inventory of all chemicals located in the Unit.

D. Ensures that laboratory instruments, communal work areas, and floors are cleaned and decontaminated.
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E. Ensures that the operating temperatures of the Unit ovens, incubators, refrigerators, and freezers are
monitored.

F.  Ensures that victim, suspect, and physiological, and reference mouth swab kits are prepared for
departmental use or for the collection of evidence at area hospitals.

G. Performs other tasks as assigned by the Supervising Criminalist.
1.3.6 INTERN/VOLUNTEERS

Interns (students) and volunteers (non-students) will assist the Unit by performing certain clerical duties,
cleaning the laboratory work areas and monitoring the operating temperature of @quipment. These activities
will always be performed under the guidance of the Laboratory Technician or Criminalist. The Laboratory
Technician is ultimately responsible for making certain any duties completed by the/interns and volunteers are

performed correctly.

Depending on the experience level of an intern or volunteer they may al§o be involved in laboratory projects
such as the validation of new technologies. This validationwerk will always be performed after receiving the

appropriate training and qualifying tests, and under the supervision of the DNA Technical Manager.

1.4 TECHNICAL LEAD CONTINGENCY PLAN

1.4.1  The Forensic Biology Unit of the San Diego Police Department currently employs multiple analysts
who meet the requifements to'be DNA Technical Manager. In the event of a vacancy in the DNA
Technical Manager position the Crime Laboratory Manager will interview the candidates and appoint
a person to fill the vacancy.

1.5 NON-CONFORMING WORK

1.5.1  Quality Incident Summary forms (FB network H:\ Worksheets\QA Worksheets) will be completed
by analysts for:
*  any malfunction or problem with laboratory equipment,
*  when control samples fail to provide the expected results,
*  when a technical policy or procedure was violated in the process of analysis, or
*  when a potential association is made to the elimination DNA database.

1.5.2  Quality Incident Summaries will address the following (if applicable):

1.5.2.1 Definition and evaluation of the non-conformance
1.5.2.2  Actions Taken to address the non-conformance
1.5.2.3 Root cause (if determined)

1.5.2.4 Reported results opinions or interpretations
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Quality Incident Summaries will be submitted to the DNA Technical Manager, or designee, to for
further evaluation. If corrective actions are required, as defined in section 8.7 of the Quality Manual,
the Quality Manager will be notified.

1.5.3.1 Non-conformances will be evaluated to determine its significance or impact on the current
analysis.

1.5.3.2 Non-conformances will be evaluated to determine its significance or impact to previous
analysis. The Quality Manager will be notified if previous work is deemed to be affected.

1.5.3.3  Appropriate actions will be taken to remediate non-conformances. Appropriate actions will
be determined based on 1.5.3.1 and 1.5.3.2.

Quality Incident Summaries will be tracked to identify trends. Ifa'trendi§identified, the Quality
Manager will be notified.

Non-conformances involving failed controls or potential associations with the elimination DNA
database with likelihood ratio HPD values greater than 99will be diselosed in the report.

1.6 PROFICIENCY TESTING

Please refer to the Laboratory Quality Manual for additienal information on the proficiency testing Program.

1.6.1

1.6.2

1.6.3

1.6.4

1.6.5

1.6.6

Each DNA analyst in the Forensie Biology Unit must complete two external DNA proficiency tests in
each calendar year with an interval between the tests of no less than four months and no more than
eight months.

The due date of thie proficiency test (as listed by the provider) will be the date by which proficiency

tests are tracked.
At least one proﬁciency test per year will involve body fluid identification.

Proficiency tests will be worked in the same manner as casework and undergo both technical and

administrative review.

Autosomal STR and YSTR testing (for those qualified) must be run on each semiannual proficiency
test.

YSTR testing must be performed on each sample that has male DNA detected.

Note: Ifa sample containing male DNA has multiple fractions (i.c., sperm and non-sperm fractions), only one

fraction must have YSTR testing performed on it.

1.6.7  Analysts must enter into the proficiency testing program within 6 months of completion of the
training program.
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1.6.8  The DNA Technical Manager will compare the results obtained by each analyst to the consensus
results from the test provider, determine the outcome of the test, and inform analysts of the

outcome.
1.6.9  Analysts will initial their proficiency test packets, acknowledging the outcome of the test.

1.6.10  Proficiency tests will be maintained by the Quality Manager.

1.7 FORENSIC BIOLOGY COMPUTER NETWORK SYSTEM

The Forensic Biology Unit employs an independent network system comprised of several servers and client
computers to share electronic data among criminalists, link instrumentation, maintain a centralized storage of
data, and provide a secure connection to the Combined DNA Index System (CODIS).

1.7.1 ELECTRONIC DATA STORAGE

Data backup is performed automatically and is managedythrough the Data Systems Department of the San
Diego Police Department. Please contact SDPD Data Systems,for additional information regarding the
management and security of the Forensic Biologyycomputer network.

1.8 LITERATURE REVIEW

Analysts within the Forensic Biology Unit will be provided copies of relevant literature (full articles, abstracts, or
miscellaneous publications) pefiodically thretighout the year. Analysts will document their review of the

circulated literature by signing offdnthéidocument management system.

1.9 QUALITY CONTROL AND CRITICAL REAGENTS

1.9.1 The following list' contains the reagents deemed critical to the DNA testing process:

"  All reagents used in the extraction of DNA (excluding dithiothreitol (DTT))
"  Qiagen DNA Investigator and QiaSymphony DNA Investigator Kits

®  All Quantifiler qPCR Kits

*  All Autosomal or Y-chromosome STR Typing Kits

1.9.2 SAMPLES AVAILABLE FOR QUALITY CONTROL TESTING

Only samples with known DNA profile results will be used to assess critical reagents. Extraction reagents will
be quality tested using dried blood samples. DNA typing and quantification kits will be quality tested using
previously extracted DNA samples.

\ Forensic Biology Unit Policy Manual v07-01-2019 Page 9 of 81




-

Unit Policy Manual

Forensic Biology

1.9.3 QUALITY CONTROL TESTING OF CRITICAL REAGENTS

1.9.3.1 Before any critical reagent can be used for casework analysis it must undergo quality control

testing.

1.9.3.2 Quality control analysis will undergo technical review and review by the DNA technical
Manager, or designee.

1.9.3.3 The results of controls, NIST SRM, and known samples must be in complete agreement with
their expected results order for a critical reagent to pass QC.

1.9.3.4 In the event that the QC data does not pass, a second QC analysis wilhbe used to confirm the
original result.

1.9.3.4.1 If the second QC analysis demonstrates thegeliabilify of thekit, it may be used for
casework analysis.

1.9.3.4.2  If the second QC confirms a problém,with the critical reagent, then the critical reagents
tested will not be approved for casework‘and, if applicable, the vendor of the reagent will

be contacted.

1.9.3.5 Critical reagents/kits will be testedd@s follows:

Extraction Reagents: Two different known samples and a reagent blank will be carried through DNA extraction
and typing. The preparation dates of the reagents and the results of the DNA testing will be documented on
the Quality Control Worksheet for Critical'Extraction Reagents.

Qiagen (EZ1 or QiaSymphony) DNA Investigator kits: Two different known samples and a several concentrated

(note: concentration factornet to exceed 8x) reagent blanks (for EZ1 only: some eluted in TE and some
cluted in water) will befearried through DNA extraction and typing. The kit, reagent strip lot numbers, and
the results of the DNA testing will be documented on the Quality Control Worksheet for DNA Investigator
kits.

Quantifiler Duo kits: The DNA standard tubes from the new lot of Quantifiler Duo kits should be defrosted,
pooled, and re-distributed into the DNA standard tubes. The new lot of kits should be used to quantify

calibrators 1 and 2 from the old lot of kits as well as three replicates of calibrators made with the current lot of
kits. Two samples with known genotypes should also be quantified using the new Quantifiler Duo kit(s), the
obtained quant values should be used to amplify those samples (and appropriate controls) using one of the
validated typing kits. All samples should produce the known genotypes and the peak heights should generally
be consistent with expectations based on the input amount of DNA. The target volume of the QC samples
will be determined based on the quantification value obtained from the new Quantifiler Duo Kit. Successtul

typing of the known samples will serve to demonstrate the reliability of the new kit lot(s).
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GlobalFiler DNA typing kits: 007 Control DNA should be defrosted, pooled, and re-distributed into the DNA

standard tubes prior to performing the QC testing. Two known samples will be typed along with the 007

Control DNA positivc control and an amplification blank. The lot numbers of all kit components and the

results of the DNA testing will be documented on the Quality Control Worksheet for GlobalFiler.

the NIST Testing policy below)

(See also

Yfiler Plus DNA typing kits: New kit lots will be tested with two known male samples, the 007 DNA positive

amplification control, and an amplification blank. The lot numbers of all kit components and the results of the

DNA testing will be documented on the Quality Control Worksheet for Yfiler.

All QC data will be stored electronically on the FB network.

1.10 NIST TESTING OF DNA PROCEDURES

Once a year, the DNA typing process will be checked against NIST or NIST<traceable standards. Previously

extracted known DNA samples can be tested alongside NISTE.SRM'samples, thus making them NIST traceable. If

kits are quality controlled using these NIST-traceable samples, thisicheck will serve as the yearly check against
NIST standards.

1.11  EQUIPMENT VERIFICATIONS

1.11.1

1.11.2

A new critical equipment (1.11.2) will require validation, or verification prior to implementation

into casework.

Verifications will' be performédron the equipment that has been identified as critical to the analysis of

samples in the Forensig Biology Unit. The equipment listed below will be assessed at the

approximate intéfyals indicated. If any of the instruments in the list is taken out of service a

verification willlbe performed prior to re-initiating casework on the instrument.

Equipment Item

Pipettes

‘ Location

Forensic Biology Main Lab and Amplification Room

Schedule (approximate)

Every six months

Balances

Forensic Biology Main Lab

and Amplification Room

Yearly

BioRobot EZ1s Volume Test

Forensic Biology Main Lab

Every six months

QIASymphony

Forensic Biology Main Lab

Annually

QiaCubes

Forensic Biology Main Lab

Annually

Hamilton Nimbus

Forensic Biology Main Lab

Every six months

Thermal cyclers

Amplification Room

Every six months

SDS 7500
Block Contamination Check
All other calibrations

Amplification Room

Every six months

Annually
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Genetic Analyzers Amplification Room Annually

Corbett CAS-1200 Amplification Room Annually

See the equipment maintenance section for additional information on equipment care.

1.11.3  Pipettes will be verified by an external service provider based on the pipette manufacturer’s
systematic (accuracy) and random (precision) error tolerances.

1.11.4 VERIFICATIONS

If any maintenance, repair, or service is conducted on a piece of equipment, a performance verification will
be performed.

1.11.4.1 QiaCubes - preventive maintenance will be performed on the instrument on a yearly basis.
After any service visit, including the yearly preventive maintenance, the QiaCube(s) will be
evaluated with a performance verification. This verification will aim to establish if the
instrument performance is acceptable for casework applications. This is accomplished by
determining if the service issues were corrected and that'the instrument(s) can still perform
the methods as expected. One way of detérmining this is to run a set of mixed sperm/non-
sperm cell samples through the QiaCube and continue the analysis through both quantification,
amplification, and CE analysis. Satisfactorysperformance will be determined by the ability to
separate the sperm and nonsspermdractions of the verification samples.

1.11.4.2 BioRobot EZ1s — every six months a volume test will be conducted on all BioRobot EZ1s to
determine whether pipetting performance is still optimal. See the equipment maintenance
protocols section (section 6) for additional information. A passing result must be within 5% of
the pipettedvolume for all'channels within the instrument.

1.11.4.3 QiaSymphony - preventive maintenance will be performed on the instrument on a yearly
basis. A§ part of'the preventive maintenance visit, the pipetting accuracy and precision are
checked for all# channels. After any service visit, including the yearly preventive maintenance,
the QiaSymphony will be evaluated with a performance verification. This verification will aim
to establish if the instrument performance is acceptable for casework applications. This is
accomplished by determining if the service issues were corrected and that the instrument(s)
can still perform the methods as expected. One way of determining this is to run a set of
samples through both quantification set-up and amplification setup protocols. Replicate
samples could also be run on the BioRobot EZ1(s) to demonstrate satisfactory performance.

1.11.4.4 Hamilton Nimbus — preventive maintenance will be performed on the Nimbus instruments
approximately every 6 months. As part of the preventive maintenance visit, the pipetting
accuracy and precision are checked for all 4 channels. This is documented in the volume
verification report.

After any service visit, including the yearly preventive maintenance, the Nimbus instruments
will be evaluated with a performance verification. This verification will aim to establish if the
instrument performance is acceptable for casework applications. This is accomplished by
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determining if the service issues were corrected and that the instrument(s) can still perform
the methods as expected. One way of determining this is to run a set of samples through both
quantification set-up and amplification setup protocols. Replicate samples may be used to
assess pipetting volume accuracy and precision during the quantification setup.

Any changes to the methods (i.e., robotic instructions underlying the procedure) will require a
modification study to determine whether the changes have adversely affected performance.

Genetic Analyzers - the QC analysis of critical reagents will serve as the annual performance
verification of the Genetic Analyzers. The QC runs performed for the various testing kits
employed by the lab will be rotated through the various Genetic Analyzers throughout the
course of the year. Performance checks separate from QC runsmay also be done using a
minimum of the amplification positive, amplification negative and-allelic ladder.

After any service visit, including the yearly preventige mainténance; genetic analyzers will be
evaluated with a performance verification. This yerification willaim to establish if the
instrument performance is acceptable for casefvorkapplications. This is accomplished by
determining if the service issues were corrected\(if applicable), electrophoresis capabilities
(i.e., resolution) are acceptable, and that,the sensitivity of the instrument has not been altered
substantially. One way of determinifig,this would'be to evaluate data from a set of samples run
pre-service and comparing it to data from,the same samples run post-service.

Corbett CAS-1200 — the performance check of the CAS-1200 will consist of an evaluation of
the instruments pipettingragainst manual pipetting of the same samples. This will be

accomplished based on the CAS-1200 pipetting of a known set of replicate samples for analysis
on the genetic analyzer. The results of the replicate CAS-1200 pipetted samples will be
compared agaifstithe same replicate samples prepared manually. Total detected peak heights
of both set§ of samples will be used to measure the performance of the CAS-1200. Although
several variable$ will affect the ultimate peak heights on the 3500, ideally the difference
between the total peak heights both sets of samples should be less than 10%.

1.12 POLICY FOR MONITORING INCUBATORS, REFRIGERATORS, AND FREEZERS

The incubators, refrigerators, and freezers in the Forensic Biology Unit will be monitored approximately every
week. The operating temperatures should be recorded on a worksheet attached to the equipment. Refrigerators
will be expected to operate at a temperature between 1 to 13°C and freezers at a temperature colder than -10°C.
Consistent deviations from the expected temperature indicate that maintenance or repair is likely required and

the Supervising Criminalist of the unit will be notified.

1.12.1 MICROSCOPES

The microscopes in the Forensic Biology Unit will be maintained according to policies outlined in the

laboratory Quality Systems Manual.
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1.13 QUALITY ASSURANCE DOCUMENTATION IN THE FORENSIC BIOLOGY UNIT

This list below indicates all the logs maintained by the Forensic Biology Unit:

Kit Receipt Log Electronic
Reagent Preparation Logs Electronic
Supply Order Log Electronic
DNA Extraction Electronic
Qiagen Robot Reagent QC Electronic
GlobalFiler QC Electronic
Y-STR QC Electronie
Quantifiler Duo QC Electronic
Unexpected Results Electronic
FB Incident Log Electronic
Staff Associations Electronic
Balance Calibration Tests (Quarterly) Electronic
Pipette Calibration Electronic
Nimbus Maintenance Electronic
Thermal Cycler Calibration & Uniformity Electronic
3500 Maintenance Electronic
Ovens & Fridges Temperature Log Electronic
Qiagen EZ1 Volume Test Electronic
QiaCube Maintenanee Electronic
Forensic Biology Unit Policy Manual v07-01-2019 Page 14 of 81
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2.0 CASE PACKETS AND REPORTS
2.1 REPORT FORMAT

The Biology Unit will use the standardized report format located in the Quality Systems Manual. Case number,
incident number, and date of occurrence will appear in the report header whenever possible. In addition to the
items listed in the Report Standard Format section of the Quality Assurance Manual, the date of the report will
be included in the initial header and on each subsequent page for multi-page reports. In general, items described
in the report will be limited to those examined or tested. Where available, CII numbers will be included in the

report.

2.1.1 BACKGROUND SECTION
A background section of the report will only be used for:

®  Describing corrections to, and referencing, original reports infAménded reports.

. Referencing external data used to render conclusions in the report.

2.1.2 CASE-TO-CASE NOTIFICATIONS
Will be issued for associations between eyidenée,items in different cases, or associations to
individuals in multiple cases. These notifications mustibe administratively reviewed prior to

issuance.

Case-to-case notifications are required when any SDPD cases have been associated through the
database to any other SDPD case, cases,from an outside agencies, or a named individual. Case-to-
case notifications will befissued for@ny newly associated cases. Cases previously associated with the
same individual do not require notifications.

FB analysts will issuc€ase=to-case notifications in the following scenarios:
=  Associations to cases without a named individual.
= Associations to individuals without CII or FBI identification numbers.

The FB Laboratory Technician (or other designee) will issue case-to-case notifications in the
following scenario:

= (Case associations to named individuals with CII or FBI identification number.

2.1.3  SCREENING REPORTS

Screening results can be summarized either through the inclusion of a table or through written
explanations of the results.

2.2 CASE PACKETS

The final packet assembled by the analyst will contain the original of the final signed report, complete
analytical record (or a reference as to where the data is located), and other important administrative
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documents (e.g., work requests) for scanning and storage by the Clerical Unit. The final packet is subject to
technical and administrative reviews before the packet is filed.

Administrative documents associated with the case packet will be handled in accordance with the policies in
the Laboratory Quality Manual.

If any information is referenced within the analytical record (e.g., a reference sample worked as part of a
different case), a pink sheet indicating that the report relies on information contained within a case packet
from a different case. This sheet will serve to notify clerical that additional material is required in the event
of a discovery request.

ANALYTICAL RECORD

In general, the analytical record will contain the following:

Documentation of relevant communications

Evidence inventory and analysis notes, including@ny serélogy tests results

DNA extraction, quantification, amplification§and capillary electrophoresis notes
DNA results (electropherograms)

Interpretation information/worksheets

STRmix results page with diagnosticiinformation of the MCMC

Statistical evaluations

CODIS worksheets printouts for any samples to be uploaded to CODIS
Disposition information forworksproduet

CASEWORK BATCHING

To streamline the administrative burden (case, packet assembly, technical review, and
administrative reyiéw)of processing large numbers of cases together, analysts may group the
analytical records for multiple cases together into a single analytical record. Each case in the
casework batch'should receive its own individual report.

Alternatively, the,analytical worksheets common to multiple cases (i.e., extraction through GMID-
X) can be technically and administratively reviewed separate from the complete analytical record.
The technical and administrative reviews shall be documented in the complete case packet, and the
analytical batch only referenced. These analytical batches must be stored on the FB network such
that they are available for review when the complete case packets are reviewed. Please see section
2.6.1 for additional information on technical review.

NOTETAKING

The analyst will take notes with the expectation that they, a technical reviewer, or perhaps an
outside expert, upon review will be able to reconstruct what was done in terms of examinations
conducted, testing completed, and any sampling.

Analysts should avoid using the names of victims of sexual assault or child abuse cases on
worksheets containing information from multiple cases to reduce the risk of the information being
revealed through the discovery process for unrelated cases.
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The condition of evidence packaging will be noted (e.g., damaged, unsealed, etc.) when evidence is
retrieved from the Property Room or Laboratory Vault.

Photographs will be labeled with a descriptor unless it is completely evident what the photograph
represents. Photographs should include scale.

Digital photographs taken in the Forensic Biology Unit will be archived so that they can be easily
retrieved, if needed, for discovery. Ata minimum, the electronic files of the photographs should
be saved with the barcode of the item in the file name in a folder labeled with the case number.

2.3 INTERPRETATION OF CONTROLS

2.3.1 SUBSTRATE CONTROLS

For any analysis, a result obtained from a questioned stain is, interpreted as being representative of the stain

when the result from the substrate control is negative.

Results from questioned stains for which the substrate contrel yields a positive result need to be interpreted
with caution. A result from a questioned stain‘may notibe representative of the stain when the substrate
control also yields a positive result. In this circumstance, the results obtained from the questioned stain

need to be considered along with the resultsiobtained from the substrate control.
Some considerations for evaluating the substrate control include:

A. The collection of the substrate control (e.g., was the control collected from a proven negative area?)

B. Results from(presumptivetest versus a quantitative test. Was the substrate control originally evaluated
as being negative by afpresumptive test, which is less specific than the confirmatory test?

C. Did the substrate ¢ontrol give a low level DNA result versus a considerably higher level DNA result
from the questioned stain?

D. The source of the substrate. Is there a stain on the substrate control, which was not identified
presumptively, which could be giving the result? It may be necessary to examine the substrate for other

body fluids.

2.3.2 DNA CONTROLS:

Please refer to the Autosomal STR Interpretation Guidelines (or Y-STR Interpretation Guidelines section)
section of the Forensic Biology Technical Manual for the policies regarding the interpretation of the

Reagent Blanks, Positive Amplification Controls, and Negative Amplification Controls.
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2.4 CASEWORK REVIEW

All casework performed by the Forensic Biology Unit is subject to both technical and administrative reviews.

Refer to the casework review policy in the Quality Assurance Manual.

2.4.1 TECHNICAL REVIEW

2.4.1.1

2.4.1.2

2.4.13

2.4.14

2.4.1.5

2.4.1.6

2.4.1.7

2.4.1.8

2.4.19

Each technical record in the Forensic Biology Unit will have a technical review conducted on it

by a second qualified analyst.

Technical review will rotate between all qualified analysts in the Forensic Biology Unit to
ensure that the process remains objective.

Technical review will ensure the accuracy of the final séportiand that/established Forensic
Biology protocols and policies are being applied to.€ase analysis.

Technical review will ensure that the conclusions in the repert are supported by the data in the
analytical record (i.e., case notes, sketches, photos, etc.):

If changes are made as a result of the technical review that affect the opinions and interpretations
in the report, the authorization datemust be,updated to reflect the date of those changes.

In general, technical review wilbbe completed within two calendar weeks. Additional analysis,
training, or vacations may delay completion within the stated timeframe.

Analysts submitting technical records for review must communicate any review timelines to the
technical reviewer.

Unresolved differences between the case analyst and the reviewing analyst will be mediated by
the DNA¥Eechnical,Manager.

The date of the completion of the technical review will be documented in the report and in the
analytical record.

The following list is meant to guide analysts in providing a complete technical review of case packets. The

list is not meant to be all inclusive and a case needs to be evaluated in its entirety to make certain that a

reasonable, competent, and complete analysis was performed.

Analytical Record
All additional materials in case file labeled with “Admin Document”
DNA request has supervisor and/or analyst initials

Notation from supervisor or communication with detective documented for requested samples that were not
tested
All other requested evidence and reference samples tested

Case file has pink case reference sheet and/or green stat sheet, if applicable
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Date, initials, page numbers, and case # / incident # on each page
Corrections are lined out, initialed, and dated (if applicable)
If applicable, permission to consume evidence obtained and/or communicated
All important communications concerning the case appear recorded
Evidence Sampling
There is an adequate description of the evidence packaging
There is an adequate written or pictorial representation for evidence examined
There is an adequate written or pictorial representation for samples collected
If applicable, photographs (if affixed to page) have proper identifying information
Proper methods were used to locate biological material
Proper methods were used to identify biological fluids
Appropriate controls were used for alternate light source and presumptivetests
Substrate controls collected and analyzed where appropriate
Documentation present that evidence was repackaged and sealed
Sub-item designations added to packaging and comments sectionfin FileOnQ
If applicable, "SART Kit Tested" field is updated in FileOnQ
Analytical Notes
Reviewed (TR/AR) Analytical Batch review page present, if‘applicable
Analytical notes not part of analytical batch contain necessary documentation
If applicable, QA Summary documentation present in notes oriin Analytical Batch
Suitable amounts of DNA amplified for evidence,and eontrols for the STR system
Positive Control results acceptable
Amplification Blank (TE) results acceptable
All associated Reagent Blanks hdve acceptable results
Electropherograms
Appropriate analysis method, panel, and size standard used for all samples
Electropherograms pfesent for all relevant samples
If altered injection times uSed; comtrols were injected appropriately
Multiple injections performed where necessary
If multiple injections;performed, results generally consistent/ expected
Artifact and allele/¢hanges labels appropriately and sufficiently
Loci with common microvariant alleles (X.1 or X.3), have no stutter peaks or alleles above detection
threshold that didmot fully resolve from neighboring peaks
Heterozygous peaks in apparent single source samples appear to be balanced
Interpretation
Assumptions regarding number of contributors are documented
Conclusions based on visual comparison are documented
STRmix run for all appropriate samples
STRmix input files imported correctly for evidence samples
If applicable, MCMC conditioned on appropriate references and the text file was imported appropriately
MCMC results appear to have appropriate genotypes, weights, and mixture proportions
If applicable, MCMC run with appropriate informed priors
STRmix database search results evaluated for possible staff matches
Comparisons were made to all relevant reference samples and the input files were correct

LRs do not have large disparities in results at any loci (i.e., LR = 0 at only a single locus)
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STRmix diagnostics within reasonable range of values
For Y-STRs, designation of major and minor contributors is appropriate
For Y-STRs, appropriate comparisons were performed and conclusions drawn
For Y-STRs, appropriate statistical assessment of evidence performed

CODIS
CODIS sheets present for applicable evidence
If applicable, MME is calculated appropriately for eligibility for SDIS/NDIS
CODIS sheets present for applicable suspects
All CODIS sheets have appropriate case #, item #, contributor %, specimen category, and offense
information
All CODIS profiles have correct specimen category and DNA types

Report
Header is correct on first page And correct on additional pages
If applicable, Supplemental Report info and Background are appropriate
Evidence examined contains correct barcode and appropriate deséription ofitems
Evidence examined contains results of presumptive/confirmatory testing
DNA typing kit(s) listed in Evidence Examined or in Conclusions
Conclusions have appropriate barcode and description (and fraction foriffs)
Conclusion lists number of contributors and mixtufeiproportions, if appropriate
Conclusions include appropriate verbal wording for, LR for €ach contributor
Reported LR for inclusions use lowest HPD fomall four, populations
Point LR reported for inclusions with no effective samplesize, and inclusions with greater than 10°
difference between LR and HPD
Disposition of evidence present
Signature block is correct

Analytical batch(s) listed in report

If applicable, Quality ASsurance Incident'documented appropriately in report

ANALYTICAL BATCH REVIEW

The review of an analytical batch (see section 2.2.2) is designed to streamline the reviewed process by not
requiring duplication of data review. The following list is meant to guide analysts in providing a complete

technical review of the analytical material in a batch.

Packet

Date on each page

Initials on each page

Page Numbers on each page

Analytical batch name on each page

O|0 |00 |0

Corrections are lined out, initialed, and dated (if applicable)

Extraction Worksheets

O Appropriate volume of Digest Buffer/ Prot. K (and DTT)

Forensic Biology Unit Policy Manual v07-01-2019 Page 20 of 81

/




Unit Policy Manual

Forensic Biology

Correct Preparation date for Digest Buffer/ Prot. K (and DTT)

Incubation time 2 required minimum

Appropriate elution volume

TE or dH2O Elution box checked

EZ1 instrument indicated for each sample

Correct Reagent Strip Lot #

O|0|(o|0o|0o|o|o

Reagent blanks included

Quantitation Worksheets

Correct Quantifiler (Human or Duo) lot #

7500 Instrument listed

Setup listed

Master Mix Preparation was accurately calculated

Calibrators are within appropriate range

TE Amp Blank is undet and IPC is green

O|0 |00 |0|0|0o

All reagent blanks are undet and IPC is green

Amplification Worksheets
Correct Amplification Kit (GlobalFileror YfilenPlus) lot #

Correct TE Prep Date

Thermal Cycler Instrument listed

Setup listed

Master Mix Preparation was accurately calculated

Correct volume for Positive Control added

Correct volumefor TE Amp Blank added

If samples combined, corresponding RBs are combined

Correct volume for Reagent Blanks added

O|0|(0|0|0|(0|(o|0|0|(o

Dilutions (and/or) concentration procedures listed below table

3500 Sample Setup Worksheets

Formamide Blank and Formamide ISS included

Ladders included

Positive and negative control included

Reagent blanks included

3500 Instrument listed

Sample setup listed

O|0 (o0 |0o|0|o|o

Correct Reagent Lot #s (Formamide, ISS, Ladder)

GeneMapper Analysis (electronically viewed)

Sample page included in packet

At least 1 evidence and 1 reference ladder passed

All GS600 — Appropriate peak heights and resolution

O|0 |0 |0

Positive Control passed
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TE Amp Blank (No detected DNA types)
All Reagent Blanks (No detected DNA types)

TECHNICAL REVIEW EXPECTATIONS

The following serves as a further clarification of the expectations with regards to the technical review

process should differences of opinion arise:

1. The Analyst and Technical Reviewer will meet in person and have a verbal conversation in an effort to
sort out any differences of opinion. Each should have the opportunity to professionally explain their
point of view.

2. Assuming the analyst and technical reviewer cannot come to an agréement; the input of a DNA
Technical Manager will be sought.

3. Should the issue raised in technical review have policy implications, thé,Teghnical Manager may need to
consider a policy change. In this case, the Technical Manager will work with the Supervising
Criminalist(s) and/or the Quality Manager to determine the best coufse of action.

4. Assuming an agreement between the Analyst, the Technical Reviewer, and Technical Manager cannot
be achieved, the Quality Manager will be asked torassist the three parties in coming to a resolution for
the technical issue.

5. Should the technical review issue still remain,unresolved the Supervising Criminalist for Forensic
Biology will be informed of the impasse.

6. Analysts involved in the discussion mayeléet to haye further discussions with the Laboratory Director
concerning the technical issue.

2.4.2 ADMINISTRATIVE REVIEW

Each case packet prepated by an-analyst is subject to administrative review. This review is normally
conducted by the Supervising Criminalist; however, in the event a Supervising Criminalist is unavailable the

administrative review may,be performed by another analyst within the section.

The Quality Manual details the basic elements of the administrative review process. In addition to those
criteria enumerated in the Quality Manual, the following list is meant as a guide to providing a complete
administrative review of case packets. The list is not meant to be all inclusive and a case needs to be

evaluated in its entirety to make certain that the report and analytical record are complete.

Notes

Worksheets are complete?

Report

Conclusions in the report are supported by the data?

Statistical frequencies provided for DNA profiles when appropriate?

Evidence disposition is summarized?
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General

Report and case notes have had a technical review by a qualified analyst?

Analyst has corrected or otherwise resolved all concerns raised by the analyst performing the
technical review?

CODIS worksheets for appropriate samples?

If SART kit is tested, has SAR-on-Q or File-on-Q has been updated (as applicable)?
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3.0 EVIDENCE POLICIES

3.1 CASE SUBMISSIONS

The Forensic Biology Unit accepts case submissions from all investigative units with the Department. Case

submissions are handled as described in the Quality Assurance Manual.

Department Order 13-30 requires a consent form when collecting DNA from a subject who is not being arrested
for a felony, is not a 4th waiver subject, is not subject to a court order mandating collection of a DNA sample, or
who is not a victim of a sexual assault. The consent form is used to inform the subject of his or her right to refuse
to have a sample collected, and will inform the subject that the sample, if collected, may be entered into a
database for comparison with other profiles. Any reference DNA sample requested must have a form submitted
in order to have the sample analyzed, unless it has been collected from a felony-arrestee, court order, 4th waiver
subject, or sexual assault victim. If no form was collected, permission from the Assistant Chief in the requestor’s
chain of command will be required to proceed with analysis. The consent form or documented Assistant Chief

approval will be maintained as an administrative document.

3.2 CONSUMPTION OF EVIDENCE
Analysts will adhere to the consumption of evidencé policyiin the Laboratory Quality Manual.

3.2.1  If the decision of an analyst is that eonsuming an item of evidence provides the best chance of
obtaining a DNA result and there is an issue with the laboratory consuming the evidence, an analyst
may agree to initially consumieshalf of the sample (predicated on the subsequent analysis of the
remaining portion of the.evidence if needed) or may suggest that an independent laboratory be
selected to perform the analysis.

3.3 FACILITIES AND EVIDENCE CONTROL

See the laboratory’s Quality Manual for lab-wide policies regarding facilities and evidence control. The

following are additional unit policies:

3.3.1  Separate areas are designated within the Unit for evidence evaluation and DNA extraction, PCR
setup, and for the amplification and analysis of amplified DNA. Procedures will be performed in
the appropriate area for that analysis.

3.3.2  Pipettes used in post-amplification processes must not be used in the pre-amplification areas
without thorough decontamination and cleaning.

3.3.3  The door of the room containing amplified DNA will remain closed except for passage.

3.3.4  Amplified DNA will only be stored in the refrigerators and freezers in the post-amplification area.
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3.3.5

3.3.6

3.3.7

3.3.8

3.3.9

3.3.10

3.3.11

3.3.12

3.3.13

3.3.14

3.3.15

3.3.16
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No reagents used in the post amplification processes will be stored in any refrigerator or freezer in
the pre-amplification areas.

Evidence and reagents should be stored separately in their designated locations while in the
Forensic Biology Unit.

Records will be maintained in the Reagent Preparation Log for any reagent prepared for casework
application. The record will indicate the preparer, the date of preparation, and the lot numbers, or
date of preparation, of components used in the preparation of the new reagent.

Any visitors to the lab areas within Forensic Biology will be required to wear a mask and gloves
during their time spent in pre-amplification lab areas. Visitors to labareas will be asked to provide a
sample for the elimination database.

Analysts must wear appropriate personal protective eqiipment when éxamining evidence. This
includes, at a minimum, a lab coat and gloves. Facemasks afe recommended.

Prior to analysis, work areas must be cleaned with a\10-20%bleach solution. The work area will be
covered with clean paper or bench mats prior téievidence analysis. The contents of items must be
inventoried and examined on a fresh piece of paper. This paper can be used to wrap the item after

examination.

After analysis, items will be returned to the original packaging. The package must be sealed with
evidence tape and the analyst must initial and date the seal. The barcode number must be on the
outer packaging. If the item cannotbe returned to the original packaging, new packaging can be

created, but the original packaging/must be packaged with the item.

Analysts must aveid compromising any information written on the evidence packaging. Notation
will be made in the case notes if the contents of the packaging could not be accessed without
breaking an existing evidence seal.

Evidence collected from the suspect(s) must not be sampled or extracted at the same time as
evidence collected from the victim. Case scenario information relating to the locations evidence
items were collected must be considered so that evidence collected from locations associated with
the victim are not extracted with evidence from locations associated with the suspect. The DNA
extraction of evidence and reference samples must be separated by time and/or place.

Swabs from the same body cavity submitted in multiple tubes within a sexual assault kit are
considered separate items and should not be considered equivalent.

The creation of microscope slides is mandatory for sexual assault evidence suspected of containing
semen any time a sample/stain will be consumed for DNA testing.

Slides or other derivative evidence generated as a result of analysis will be assigned a new barcode
in File-on-Q system, a notation as to final disposition will be made in the notes.
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3.3.17

3.3.18

3.3.19

3.3.20

3.3.21

3.3.22

3.3.23

3.3.24

3.3.25

3.3.26

3.3.27
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If an evidence item is swabbed for DNA analysis, a notation will be made within the File-on-Q
evidence tracking database regarding any additional associated barcodes created.

Scissors used for sampling evidence must be cleaned thoroughly with bleach, soap and water,
alcohol, or by flaming between sampling different stains. Alternatively, a fresh scalpel blade will be
used for each evidence sample.

For any procedure performed in the Forensic Biology Unit only one tube or evidence item should
be open at a time during any sampling and reagent/ DNA addition. Use of any robotics system for
sample setup is an exception to this policy.

All reagents and solutions will be autoclaved where possible. Sterile water and sterile plastics or
glassware will be used for solutions that cannot be autoclayed.

Reagents will be stored as small aliquots to minimizefthe efféets of any contamination events. The
lot(s) of reagents used for each set of analyses willbe recorded.

Sterile disposable aerosol resistant pipette tipsjand sterile tubes will be used for any processes
involved in DNA analysis. Pipette tips wilhbe changed between adding or removing liquid from
evidence sample tubes.

The DNA extraction/purification of questioned samples will be performed separately from the
DNA extraction/purification of reference samples. In addition, it is advisable that DNA
extraction/purification of samples,avhere high amounts of DNA are expected, (references or large
bloodstains) be performedseparately from samples where low amounts of DNA are expected
(single hairs or vefy small stains)sf6 minimize the potential for sample to sample contamination.

At least one reagent blank will be employed for each set of DNA extractions/purifications to check
for possibléigontamination of the DNA extraction reagents. A reagent blank will be subjected to all
of the reagents'andimanipulations of the DNA analysis process as evidence samples. It is advisable to
employ mulfiple reagent blanks in a batch extraction to accommodate the combining of samples, or
the use of multiple DNA testing kits if any samples are consumed during a first analysis.

Reagent blanks must be treated in the same manner as the most manipulated evidence sample
associated with it. The reagent blank will be carried through amplification and analysis with its
associated samples.

When performing manual PCR setup, DNA must be added to the tubes after all reagents
have been added. This practice reduces the possibility of inadvertent transfer of DNA between
samples and kit reagents. Only one sample tube should be open at a time during DNA addition.

Only disposable lab coats are to be used in the post-amplification arca. Always remove gloves and
lab coats before exiting the post-amplification area.
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3.3.28 All surfaces in the Amplification Area should be cleaned with 10-20% bleach solution before and
after setting up samples for analysis.

3.3.29 All equipment found in the Amplification Area is dedicated to that area and will never be removed
unless proper decontamination procedures have been employed.

3.3.30 DNA interpretations must be documented in the analytical record.

3.3.31 CODIS sheets for evidence samples must be part of the analytical record.

3.4 DNA SAMPLE STORAGE

3.4.1 Short term storage of extracted DNA will be the dedicateddreezer in the PCR setup area. DNA
extracts should be stored in closed containers or sealed bags.

3.4.2  Long-term storage of extracted DNA will be in the'Property Rogim. A new barcode number must
be created for extracted DNA samples. All new items,in Filexon-Q require an incident number to
be assigned. Any new incident number assignedito extracted DNA samples will follow the format
of: “ExtDNAanalystthreeletterinitiasMMDDYX.

3.4.3 Storage of Amplified DNA samples will be inthe dedicated freezer in the Amplification Area.
Under no circumstances will amplified DNA be'stored outside the Amplification Area.

3.4.3.1 Amplificd DNA samplcs will be maintained for a period of six months from the date of
amplification. After this time, the amplified DNA will be discarded.

3.5 POLICIES REGARDING FREEZER PACKETS

Freezer packets are'eréated to store derivative evidence separated or prepared from other evidence that is

customarily stored unfrozen.

Anytime a freezer packet is made for derivative evidence the following information (at minimum) should be

clearly marked:

-Incident number or Case number (if available)

-Barcode number(s) of the evidence contained within

Any derivative evidence (stains, cuttings, or swabs) that will be impounded into the Property Room as
additional evidence will require the generation of a new item in the barcode system under the appropriate

incident number. Documentation of the newly generated items should be included in the case notes.
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When items that already have a barcode number (or a sub-designation from an existing barcode number) are
packaged together, and the packaging is given a new barcode number for the purposes of storage, the
barcode of the packaging is for temporary storage purposes and does not become the designator for the items

inside.
3.6 UNIQUE IDENTIFIERS

General:

Items stored in the Property Room or Laboratory Vault should have a unique identifier. The barcode number
uniquely identifies each item stored in the Property Room or Laboratory Vaultsunder the File-on-Q system.
Items stored under the old system will be uniquely identified by the case number (or'lab sequence number),
property tag number, and item number. Multiple items contained within a single package (e.g., the contents of
a SART kit) should all be given a sub-item designation, which should'be noted in‘thé barcode system for that

item.

Any stains, cuttings, or swabs taken of items that will be fmpounded into the Property Room as additional

evidence will require the generation of a new item in the barcodeystem under the appropriate incident number.

All items included on a laboratory request to He examiinediby the laboratory (excluding internally produced
requests) are considered evidence. All celljpellets, extracted DNA, and amplified DNA will be considered the
work product of the DNA laboratory.

During the screening and DN Adanalysis offevidénce it is common to have samples contained in microcentrifuge
tubes. These include question stains;meference samples, cell pellets being preserved for possible DNA analysis,
and extracted DNA. Each sample analyzed within a batch will be labeled with an identifier that will uniquely
identify it during its analysispAdditional descriptors may be employed to identify particular samples such as “NS”

to identify non-sperm fractions of extracts, or (Y) to denote a Y-screen extract.

3.7 DISCONTINUING ANALYSIS OF SAMPLES

Variables, such as the existence of other probative samples, or the case scenario may affect the decision to
discontinue the analysis of a sample. Quantification information may provide additional insight into the
likelihood of obtaining interpretable DNA results, and the decision to discontinue analysis may best be made

after quantification of the sample(s).
In general, analysts may discontinue analysis of samples under the following circumstances:
If a sample contains insufficient DNA to reasonably obtain an interpretable DNA profile, it may be discontinued.

An analyst may be reasonably sure that the sample has insufficient DNA to produce a full DNA profile if a large
enough proportion of the sample has been quantified, such that, based on the estimated amount of DNA in the
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rest of the sample, amplification of the entire sample is unlikely to yield an interpretable DNA profile.
Discontinuation of samples is dependent on circumstances of the case, as sometimes even limited information

may be beneficial to the investigator(s).

The intent of this policy is to be able to discontinue analysis on single samples from items/cases that are unlikely
have enough DNA to obtain a DNA profile. In cases where multiple samples from the same item are collected
for the same purpose (e.g. DNA sample collected from two different areas on a shirt for wearer information), if

one sample has sufficient DNA additional samples collected for the same purpose may be discontinued.

Touch/Wearer DNA Evidence
If the amount of total DNA in the extract is less than or equal to £0.0005ng/ ulf;"the samples are unlikely to yield
interpretable DNA results with the GlobalFiler amplification kit and the safaple may be discontinued.

Child Abuse Cases
Prior to discontinuing analysis on Child Abuse cases, the most potentially probative evidence item(s) negative for

male DNA require microscopic examination to confirm no semenis present.

Sexual Assault Cases
Given the correlation between the amount of DNA in‘a,sample and the likelihood of obtaining interpretable

DNA, the decision to discontinue analysis mayibest bie made after quantification of the samples.

If the sperm fraction is probative, fit should centain a detectable amount of male DNA to proceed with DNA
analysis. If the sperm fraction is being typed, the associated non-sperm fraction can be discontinued.

If the non-sperm fractiof is probative and male DNA is detected in the sperm fraction, both the sperm and
non-sperm fractions mustbe/DNA typed.

If the non-sperm fraction igprobative and no male DNA is detected in the sperm fraction, only the non-
sperm fraction needsfo be DNA typed.

If no male DNA is detected in the sperm fraction and the non-sperm fraction has no male DNA or a ratio of
human:male DNA greater than 75:1, the analysis of both fractions can be discontinued. In this situation

YSTR testing may be performed if a suspect reference sample is available.
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4.0 CODIS

The Combined DNA Index System (CODIS) is a nationwide forensic DNA database managed by the FBI. It consists
of DNA databases at the local (LDIS), state (SDIS), and national (NDIS) levels. The purpose of CODIS is to develop
investigative leads by matching DNA profiles of two or more samples from these various categories. The database
primarily consists of casework evidence profiles and convicted offender profiles. Sample categories include Forensic
Unknowns (single source profiles), Forensic Partials (single source, but partial profiles), Forensic Mixtures,
Convicted Offenders, Arrestees, Suspects, Unidentified Human Remains, Missing Persons, and Relatives of Missing

Persons.

The CODIS software searches for genotypes that are represented by the list of allelésuploaded at each locus. Not all
genotypes represented by the listed alleles may be accepted based on the interpietation of'the evidence. For
example, if four alleles at a locus are submitted to CODIS from a 2-persondnixturey, the search will return hits against
any homozygote genotype represented by the listed alleles. Based on the interpretationof a 2-person mixture, any
homozygote genotype would be excluded as a possible contributor, €venthough C@DIS would return a hit to it. The
case analysts are responsible for determining what is being searched in CODIS)in their assigned cases and what

genotypes would be acceptable at each locus.

Consultation with the CODIS Administrator for searches of.complex mixtures is encouraged. If the CODIS
Administrator is consulted, documentation of the €onsultation will be made on the CODIS sheet; however, the
technical reviewer is still mandated to assess thestypesand the sample itself as being acceptable for CODIS. Technical
reviewers will document this review by initialing and.dating the CODIS sheet. Any material changes made to the
CODIS sheet as a result of the technical review must be documented. Any material changes made by the CODIS
Administrator after technical revies is completeémust be discussed with case analyst and documented within the

analytical record.

4.1 ENTRY OF DNA PROEILES INTO CODIS

The SDPD Forensic Biology Unit’s procedures for the entry of DNA profiles into CODIS will be based upon the
guidelines outlined in the NDIS Procedures and the California Penal Code.

Many different situations may be encountered in forensic casework that will influence which DNA profiles, or
what portion of a DNA profile, are acceptable for entry into CODIS. The following are meant as guidelines and

do not cover every possible scenario.

"  DNA profiles selected for entry into CODIS are submitted on forms referred to as CODIS sheets. These
must be technically reviewed to ensure accuracy of the DNA types and specimen category, and acceptability
for CODIS entry. If multiple items from the same case have the same DNA profile, only one CODIS sheet
should be used.
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®  Forensic mixture and forensic partial DNA records submitted to NDIS shall be reviewed to ensure the DNA
records satisfy a statistical threshold for match rarity of approximately one in the size of the NDIS database.

"  DNA profiles (single source or mixtures) from possible perpetrators derived from evidence should be
entered into CODIS, unless that evidence was collected from a suspect. In addition to the general eligibility
requirements for DNA profiles outlined by NDIS guidelines, the suitability of any given DNA profile for
submission to the various levels of CODIS is generally dependent on the discrimination power of the DNA
profile as compared to the number of DNA profiles contained within the given database.

=  DNA profiles or portions of DNA mixtures attributable to victims or elimination reference samples
(boyfriend, husband, etc.) should not be entered into CODIS. Forensic profiles that are ultimately linked to
consensual partners will be removed from the database.

®  CODIS sheets should be filled out for suspects that were not matched to@n evidence sample or that were
included as possible contributors to a DNA mixture (see section 4.2 for,additional information on suspect
DNA profiles). These profiles are considered “Suspect Known” DNA profiles. DNA profile information
will be entered into the local CODIS database (LDIS), also known asdhe SDPD’s local DNA database, for
any suspect (or possible suspect) sample submitted for DNA analysis. Thése DNA profiles will be
maintained indefinitely within LDIS.

®  Upon confirmation of their status as a suspect by the submittingdetective, “Suspect Known” DNA profiles
will be uploaded to the State CODIS Database{SDIS)., Suspect Known DNA profiles will remain at SDIS for
as long as they are permitted under SDIS regulations.

" In general, CODIS sheets will be removed from the case file during the administrative review and given to
the CODIS Administrator for entryf Copies of\CODIS sheets must be retained within the analytical record
as numbered pages.

®  CODIS profiles will be reviewed forcligibility, correct DNA types, and appropriate specimen category
prior to upload or searchiof SDIS.

®  Searches of profiles in thelo¢al DNA database may be done prior to technical review of the case file.

4.2 UPLOADING SUSPECT DNA PROFILES

The passage of Proposition 69 in 2004 allows DNA profiles from suspects to be entered into the California State
CODIS database so long as the individual remains a viable suspect in the case for which their sample was
submitted. The proposition states that DNA profiles from suspects must be removed from the State CODIS
database after two years unless written documentation that the individual is still a suspect is received by the State
CODIS Administrator from the agency submitting the suspect DNA profile. Written documentation must be
submitted to the State CODIS Administrator every two years for a suspect profile to remain in the State CODIS
Database. The SDPD laboratory will remove suspect DNA profiles from the State CODIS Database when a
profile has been in the State CODIS Database for a period of two years. Should a suspect with their profile
entered into the State CODIS Database be eliminated as a suspect in the case for which their sample was

submitted, the DNA profile from that individual will be removed from the State CODIS Database.
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No DNA profiles obtained from juveniles (i.e., under the age of 18 at the time of collection) will be stored in the
local CODIS database.

Procedure for Uploading ADULT Suspect DNA Profiles from the SDPD’s Local DNA Database

Only DNA profiles generated from adult suspects who are (1) arrested for a felony, (2) subject to conditions
associated with fourth waiver status, (3) mandated by a court order to provide a DNA sample, or (4) consent to

the collection of their DNA by signing a SDPD Consent Form will be entered into the Local CODIS Database.
Procedure for Uploading / Removing Suspect DNA Profiles from the State CODIS Database

1. For each suspect DNA profile entered into the SDPD’s local DNA database a formletter will be sent to the
case detective. This letter requests the detective indicate whether®r not'the person in still considered to be
an active suspect in the investigation.

2. If the detective indicates that the person is considered to befan active suspect, the suspect’s DNA profile is
uploaded to the State CODIS Database.

3. After two years the suspect’s DNA profile is remoyedfirom the State CODIS Database.

4. Form letters documenting active suspect status will'be maintained for the duration of the profile remaining
in the State CODIS Database.

4.3 DATABASE SEARCHES AND/MATCHES

Searches of the SDPD’s local DNA. database can occur prior to technical review and are also
performed at theftime of the entry of the profile into CODIS. Searches of the state database are
performed by the staté (California Department of Justice). Searches of the national database are
performedby.the (FBI)laboratories. DNA profiles are uploaded to the state database at least once a
week to coincide with database searches and with the uploading of DNA profiles from state to
national databases.

Information contained within the SDPD’s local DNA database (SDPD’s LDIS) may be shared with
accredited forensic DNA laboratories in other jurisdictions. Similarly, information from the LDIS of
accredited laboratories from other jurisdictions may periodically be shared with our laboratory. In
these instances, a “batch file” containing the information within LDIS will be provided for the purpose
of comparing DNA profile information between jurisdictions. When the SDPD Crime Laboratory
receives a batch file from another agency, the batch file is used for a search against LDIS. The data
from the external agency is not stored with the SDPD’s LDIS and ownership of the data is retained by
the agency from which it originated. It is the understanding of our laboratory that outside agencies
will take the same approach with our LDIS information.

There are two basic types of database matches that could provide an investigative lead: forensic hits
and offender hits. Forensic hits involve the matching of unknown profiles from two cases. Offender
hits involve the matching of a Forensic Unknown to a Convicted Offender.
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4.3.4 Potential database matches at the State and National levels will be evaluated by the CODIS
Administrator (or designee).

4.3.5 Potential CODIS hits will be evaluated for “goodness of fit”. If the potential match is deemed to be
good, at that time the notification process will be allowed to proceed. “Goodness of fit” of any
potential database match will be dependent on the specimen category.

4.3.5.1 Potential matches between forensic unknowns and any sample in a single source sample
index (e.g., convicted offender) can be assessed visually.

4.3.5.2 Potential matches between a mixture or partial DNA profile and any sample in a single
source sample index will be assessed through calculationfof a likelihood ratio.

Note: The likelihood ratio will assess the probability of theievidence given the DNA profile
from the putative match is a component of thednixed6r partial DNA profile searched against
the probability of the evidence given the DNA profile fromfthe putative match is not in the
mixed or partial DNA profile searched.

4.3.5.3 If a potential match is between a profile in‘the local suspect category and either a mixture, or
partial DNA profile, the local suispect profile must have the full complement of data for the
likelihood ratio comparison being reported (i.c., if the local suspect only has data at 15 loci,
the reference sample mustbe tested for the full GlobalFiler dataset).

4.3.5.4 In general, the lik¢lihood ratio results used for the assessment will be the lowest 99% 1-
sided HPD value for the four population groups.

4.3.5.4.1 Potential associations to the database with likelihood ratio results greater than fifty times
the size ofthe relevant database in these comparisons will be declared as offender or
forensic hits.

4.3.5.4.2 For/comparisons with the local database, potential associations with likelihood ratio values

less than the size of the local database will be disregarded.

4.3.5.4.3 Potential associations with State and National databases will be evaluated by the CODIS
Administrator, or designee. Additional data may be requested from the jurisdiction with
which the putative hit has occurred to further evaluate its validity.

4.3.5.4.4 Likelihood ratio results between one and fifty times the size of the local database will be
further reviewed to determine if the putative associations will be reported.

4.3.5.4.5 Likelihood ratio results used to assess forensic and offender hits will be retained in the case
record, or electronically (G:\Misc DATANCODIS\CODIS Matches).
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4.3.5.4.6 If the database LR results are sufficiently high (e.g., 1.0x10"" or greater), it may not be
necessary to perform an LR with HPD calculation as the value considering the HPD is

unlikely to be less than the likelihood ratio threshold.

The matching of two evidence samples known or suspected to be from the same person is referred to
as a benchwork match. When an evidence sample has already been linked to a suspect and then
matches the same person who is in the database as a Convicted Offender sample, this is referred to as
a conviction match.

Information regarding forensic and offender hits must be included in at least one report. Prior to a
match report being written, investigators may be contacted regarding DNA matches. Information
must be communicated accurately. A communication of a database hit must be documented in a
communication log. Prior to releasing database hit information tefan investigator, the results must be
reviewed by a second analyst and the review documented in thenotes.

When likelihood ratios are calculated comparing any suspect profile from the local CODIS database
to any mixture or a partial evidence profiles, the suspect profile must have all the loci contained in the
evidence sample. This requirement applies even if the suspectreference was associated to a Forensic
Unknown (i.e., single source) component of aymixture,

4.4 MAINTENANCE OF AN ELIMINATION DATABASE IN CODIS

Section 3.0 in the Quality Manualraddresses thisiatabase. The following are the rules for the collection and

analysis of these samples:

4.4.1

4.4.2

4.4.3

4.4.4

4.4.5

The Quality Manager, will coordinate sample collection of reference mouth swabs from the donors

and coding of thesample.

Mouth swab samples from donors to the elimination database will only be retained with permission

from the donor.

Elimination database samples will be analyzed by a qualified DNA analyst following the protocol
used to analyze reference mouth swabs in casework.

The DNA Technical Manager or CODIS Manager will review the analysis prior to entering the
DNA profiles in any databases used for comparisons to evidence.

Electropherograms will be maintained for each sample.

4.5 REPORTING DNA RESULTS ASSOCIATED TO THE ELIMINATION DATABASE.
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When an evidence DNA profile is found to match or potentially be associated with a profile in the
climination DNA database, the following will be done:

The CODIS match detail report, or first page of the STRmix Database Search report indicating the
association will be included in the analytical record.

If the DNA profile in the case was found to match (or the mixture potentially includes) DNA from
any elimination profile at an HPD LR value above 100 (i.e., moderate support for inclusion or
above), a Quality Incident Summary form will be completed detailing the association.

The Quality Incident Summary form will be submitted to the DNA Technical Manager, or
designee. Any associations with HPD values above 100 will be rettedithrough the Quality
Manager.

Per section 1.5, associations to the elimination databasé when,the HPID'LR is greater than 99 will
be reflected in the report.

O If the HPD LR value is greater than moderate support forfinclusion (i.c., LR>10%), the analyst

will condition the evidence profile on.the elimination sample. The report will list the
elimination sample as an assumed gontributor.

O If'the LR value is in the modérate support for inclusion (i.e., 10°’<LR>10%), the report will list

the elimination sample as.havingmoderate support for inclusion, and the HPD LR value will be
reported.

4.6 OUTSOURCING

In order for the SDPD Crime Laboratoryto accept outsourced data for the purposes of searching the CODIS

databases the following@'eriteria must be met prior to the initiation of analysis by the vendor laboratory:

®  The vendor lab selected for the analytical testing must be accredited and the documentation of that
accreditation, including the vendor laboratory’s latest external audit report including responses and follow-
up must be provided to the SDPD Crime Laboratory.

"  Prior approval by the DNA Technical Manager of the technical specifications of any DNA analysis to be
performed by the vendor laboratory is required.

"  For any new outsourcing agreement an on-site visit to the vendor laboratory by the DNA Technical
Manager, or another qualified analyst, is required.

ON-SITE VISITS TO VENDOR LABORATORIES

For any new outsourcing agreement, the DNA Technical Manager, or another qualified (or previously
qualified) analyst designated by the DNA Technical Manager or Supervising Criminalist, will perform an on-

site visit of a vendor lab prior to the initiation of analysis on the outsourced samples.
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An on-site visit to a vendor laboratory shall include at a minimum:

®  An evaluation of the laboratory facilities to ensure the integrity of the evidence will be maintained while in
the custody of the vendor lab.

®  An evaluation of the procedures as they relate to ensuring minimal loss or contamination of the evidence
while in the custody of the vendor lab.

®  An evaluation of any Corrective Actions taken by the laboratory in the previous six months prior to the
on-site visit.

®  Aninterview with the vendor laboratory’s DNA Technical Manager or laboratory analyst.

The on-site visit will be documented in a report that will be maintained byshe DNA Technical Manager.

If an outsourcing agreement with a vendor lab is continued from on@ year to'the next, then an on-site visit to
the vendor laboratory by another NDIS participating laboratorydsing the same “technology, platform, and
typing test kit may be used. Documentation of the on-site visit,by a seconddNDIS participating laboratory must
be obtained by the SDPD Crime Laboratory before any new analysis isinitiated in the new year of the

agreement .

4.6.2 REVIEW OF OUTSOURCED DATA

Prior to uploading outsourced data into"the databases of the Combined DNA Index System (CODIS) a
technical review of the data will be performedg The' review of the data will be performed by a qualified (or

previously qualified) DNA analyst andwwill be documented and include:

®  Areview of the analytical sécordtarinclude all controls (ladders, positive and negative amplification
controls, and blanks.

®  Areview of thelvendorlaboratory’s final report to ensure that the results/conclusions are supported by
the data, and thatieath tested item (or its probative fraction) is addressed.

®  Areview of the data for all submitted samples to the vendor laboratory.

® A verification of the DNA types, eligibility, and correct specimen category of any sample to be uploaded
to the CODIS databases.

4.7 REINTERPRETATION OF LEGACY AMPLIFICATION KIT DATA

According to the FBI Director’s Quality Assurance Standards for DNA Testing Laboratories standard 13 states, an
analyst can only interpret data generated by the amplification test kit in which he or she is currently proficiency
tested, therefore if the analyst is not currently proficiency tested in an amplification test kit previously used by

the laboratory (i.e., a legacy amplification kit), the analyst cannot reinterpret the legacy data.

This policy is intended for situations when an analyst is required to reinterpret data generated with legacy
amplification test kits for a comparison made to DNA profiles generated with amplification test kits in current

use.
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Reinterpretation of legacy data may occur in accordance with the following:

1. Ifan analyst is currently qualified in an amplification test kit (trained and proficiency tested), and the
analyst was previously qualified (trained and proficiency tested) in the legacy amplification test kit,
the analyst can reinterpret the legacy data if the analyst has been proficiency tested on the legacy test
kit within the last two calendar years. If an analyst has not been proficiency tested on a legacy test kit
within the last two calendar years, then the Technical Leader must document and approve the
completion of the analyst’s review of the validation data and standard operating procedures of the
legacy test kit. If an analyst, who has completed the requirements to interpret legacy amplification
test kit data, has not reviewed the required documents within the last two calendar years, the

Technical Leader must document and approve the completion of the analyst’s additional review.

2. If an analyst is currently qualified in an amplification test kit (trained and‘proficiency tested), but has
never been previously qualified in the legacy amplification test kit, the analyst can reinterpret the
legacy amplification test kit data if the analyst is trained in_the legaeytest kit interpretation protocols
by a previously qualified analyst. The review of the validation ddta and standard operating procedures
of the legacy test kit, training by the previously qualified‘analyst, andyinterpretation competency test
must be completed by the analyst, and documented and approved by the Technical Leader.
Documentation shall contain sufficient information for\an auditor to confirm the analyst is qualified to
reinterpret legacy amplification test kit datal,

3. Ifapreviously qualified analyst is unavailable,to train a currently qualified analyst on a legacy
amplification test kit, it is highly récommendedithat the current analyst not reinterpret legacy data.
However, if the current analystimust perform legacy interpretation without training from a
previously qualified analysts then it is recommended that the currently qualified analyst and Technical
Leader train in the legacy test kit interpretation protocols, review validation data and standard
operating proceduresiThe training and interpretation competency test must be completed by the
analyst, and documented and approved by the Technical Leader. Documentation shall contain
sufficient informationdor an‘auditor to confirm the analyst is qualified to reinterpret legacy
amplification test kit data.

4. If a laboratory generates new interpretation protocols from legacy validation data (e.g., developing a
stochastic threshold when none previously existed), the laboratory shall document the basis for the
new interpretation protocols. These new protocols shall be documented in the laboratory’s standard
operating procedures and memorialized in the Quality Assurance Standards Audit Document. The
training and interpretation competency test must also be completed by the analyst, and documented
and approved by the Technical Leader. Documentation shall contain sufficient information for an
auditor to confirm the analyst is qualified to reinterpret legacy amplification test kit data.

Technical reviewers of reinterpretations of the legacy data are held to the same training requirements as the

analyst reinterpreting the data.
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5.0 LABORATORY MAINTENANCE

5.1 GENERAL LABORATORY MAINTENANCE

All members of the Forensic Biology Unit are responsible for the general upkeep of the laboratory including
stocking supplies, and cleaning common areas. Protective gloves and a laboratory coat should be worn when
cleaning the laboratory or instruments. The following maintenance and cleaning policies are in addition to the
cleaning required by analysts prior to and after using any bench area or instrument for analysis.

WEEKLY DUTIES

®  Monitor the operating temperatures of all freezers, refrigerators, and incubators. Log temperatures on the
log sheets attached to instrumentation. When a sheet has been completed, it should be scanned into the FB
network and moved to the appropriate folder within the QA-QC folder.)The scanned sheet should be saved
using a file name that clearly indicates what instrument the log isffor and what tifne period it covers.

e  Fill distilled water carboys, reagent alcohol bottles, 10-20% bleach solution bottles, and Liquinox detergent
bottles.

®  Wash glassware and dishes. Return washed dishes to'their appropriate storage location.

5.1.1 Glassware Washing

Protective gloves and a lab coat or‘apron should'be worn.

1. Wash glassware in wafm water withgéiquinox detergent.
2. Rinse detergent from'glassware by rinsing in tap water.
3. Rinse ecach piece of'glassware in distilled water.

4. Set glassware to dry.

5. Return glassware to appropriate storage location when dry.
MONTHLY DUTIES

® Restock and organize supplies and workstations.
®  Wipe counters with 10-20% bleach solution.

®  Wipe/dust all instrument exteriors with ethanol.
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® (Clean centrifuges with 10-20% bleach solution followed by distilled water.

®  Wipe inside of hoods with 10-20% bleach solution and plastic/exterior surfaces with ethanol.

®  Clean interior and exterior of drying boxes with 10-20% bleach solution.

®  Wipe/dust all shelving units.

®  Wash EZ1 strip and tip holders, QiaCube tip waste drawer inserts, and QiaSymphony sample and elution

racks.

®  Vacuum floors (except post-amplification room floor).

®  Mop (or Swiffer) the floors using 10-20% bleach.

®  (Clean sinks.

Record the completion of cleaning tasks in the Monthly €leaningWorksheets and submit them for scanning in

the Maintenance Logs.

5.2 MAINTENANCE LOGS

The following cleaning logs will be maintained by the Forensic Biology Unit. They are intended to ensure

laboratory areas are kept in a clean state. JAny cleaning should be entered electronically into the FB cleaning log

excel workbook.

Cleaning Logs Location Frequency
Front extraction area with microscopes | Electronic Monthly
Main extraction/purification Electronic Monthly
PCR Setup and Post-Amplification Electronic Monthly

5.3 DISPOSAL OF HAZARDOUS WASTE

There are six waste streams within the Forensic Biology Unit that should be handled as hazardous waste.

These are as follows:

5.3.1 PHENOLPHTHALIN CONTAMINATED SWABS
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5.33

5.3.4

5.3.5

5.3.6
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Phenolphthalin contains ethanol and swabs contaminated with it will go into appropriately
labeled waste buckets. After the swabs have dried the swabs can be disposed of in the

regular trash.

PHENOLPHTHALIN AND LMG LIQUID WASTE
Phenolphthalin and LMG liquid waste contains zinc; a heavy metal. The unusable liquid

waste will be stored in the Chemical Storeroom for disposal. The bottles should be
appropriately labeled with the hazard (flammable for pheno and corrosive for LMG). The

zinc contained in both reagents should also be noted on the log.

QIAGEN REAGENT WASTE (EZ1 or QiaSymphony)

EZ1 strips are flammable because of the ethanol they contain and should be\placed in the
designated waste containers by the instruments. All tips, tip,holders, and tubes can be
disposed of as regular trash. When the EZ1 strip waste containers are full the waste can be
transferred to the Chemical Storeroom for disposal. Liquid QiaSymphony waste can also be
transferred to the Chemical Storeroom.

FORMAMIDE WASTE
Formamide is a known teratogen and the formamide waste will be disposed of in the waste

bucket in the amplification room. Whenfull the waste can be transferred to the Chemical

Storeroom for disposal.

BIOHAZARDOUS WASTE
Large volumes of liquid blogd are biohazardous. Any large volumes of blood and the

materials used to cléan them upyshotld be disposed of in red biohazard containers.

NON-HAZARDOUS WASTE

Small volumestof blood that will dry within a reasonable amount of time can be disposed of in the
regular trash., MG test swabs can be disposed of in the regular trash. All plasticware (e.g., tips,
tubes, transfer pipets, etc.) and gloves can be disposed of in the regular trash. Acid phosphatase test

swabs can be disposed of in the regular trash and any waste liquid down the drain.
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6.0 EQUIPMENT MAINTENANCE PROTOCOLS

6.1 USE AND MAINTENANCE OF THE WATER SYSTEM

The ultra/nano pure system uses the distilled water reservoir as its water source.

Ultra pure water

The Barnstead NANOpure ultra pure water system removes ions from water. It is meant to be used with
pretreated water. Hence, the water used is first distilled. The system can be set to three different modes: off,
standby, and on. The system is left on standby when not actively in use to allow water to be circulated
through the cartridges for five minutes out of every hour. This extends the lifetof the cartridges. When ultra
pure water is needed, set the system to the on mode by pressing the ‘ON/STANDBY / OFF’ button until a
numerical value appears. This number represents a resistivity measurementiof the water, which indicates its
purity. Wait for the number to increase to at least 18.0 before diSpensing. If'thi§ number remains below
18.0, then the cartridge is no longer efficiently deionizing thegwater.#A carboy is used to collect and store
ultra pure water, as the system produces purified water rather'slowly.\The ultra pure water system should
never be used when the distilled water reservoir is emptya, A low,water protection device has been built into

the distilled water reservoir to prevent the ultra pure water system from operating when the still is low.

6.2 OPERATION OF THE pH METER:

Thermo Scientific Orion Star A111 pH Meter Operation

Electrode Preparation

Disconnect electrode fromynieter.

Uncover the fillinghole and'add electrode filling Ag/ AgCl solution.

Solution must be above reference junction and at least one inch above sample level.

The filling hole must be open when electrode is in use and closed when in storage.

Gl A W N =
Jtr o

Place the electrode in the electrode holder and suspend it in air for 5 minutes so that the solution in the
clectrode can thoroughly wet the reference junction.
Shake electrode downward (similar to a thermometer) to remove air bubbles.

N o

Soak electrode in pH electrode storage solution for 30 to 60 minutes.
8. Connect electrode to meter.

Electrode Storage

1. Short-term Storage (up to one week)
a.  Soak the electrode in pH electrode storage solution.

b.  To prevent crystallization of the fill solution, cover the fill hole whenever the electrode is being stored and
open the fill hole when calibrating and measuring.

2. Long-term Storage (more than one week)
a.  Fill the reference chamber and securely cover the filling hole.
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b.  Cover the sensing element and reference junction with the protective cap/sleeve containing a few drops
of storage solution.
c.  Before returning the electrode to use, prepare it as a new electrode.

Electrode Maintenance

1. Inspect the electrode for scratches, cracks, salt crystals.

2. Rinse off salt crystals with DI water.

3. Drain the reference chamber, flush it with fresh filling solution and refill the chamber with fresh filling
solution.

Electrode Cleaning
1. Soak electrode in 0.1 M HCL or HNOS3 for 30 min.
a. Can also be soaked in a 1:10 dilution of household bleach mixed with hot water (stir at fast rate).
2. Drain the reference chamber and refill it with fresh filling solution.
3. Soak the electrode in pH electrode storage solution for at least 1 liour.

Calibration

Prepare the electrode according to the electrode preparation instructions.
Connect the probe to the meter and turn on the meter.

Press mode to display pH for the pH measurementymode:

Select 2 pH buffers that bracket the pH you aré targeting.

Press Cal

Rinse the electrode in DI water and blot With adkim wipe.

Place electrode into first buffer.

Wait for “Ready” then record value in log book:

O 0 J O\ U1 A W N~

Rinse the electrode in DI water and blot with a kim wipe.

—_
=]

. Place electrode into seconddbuffer.
11. Wait for “Ready” then@record value in log book.
12. Rinse the electrode in DIwater and blot with a kim wipe.

Measurement

1. Perform Calibration steps first.

2. Make sure itis in pHimeasurement mode.

3. Press measure: the meter will immediately start taking readings.

4. When “Ready” is displayed the meter stops measuring the pH, so you may need to press measure
multiple times when pH-ing the solution.

5. When you reach the target pH rinse the electrode in DI water and blot with a kim wipe.

6. Turn pH meter off.

Store electrode according to the Electrode Storage directions provided.

6.3 OPERATION OF THE AUTOCLAVE

The autoclave is used to sterilize critical reagents and equipment via steam pressurization. There are two exhaust
selector settings on the autoclave: FAST (Instruments) and SLOW (Liquids). Use the slow setting when only

liquids or liquids and equipment are being sterilized. If sterilizing equipment use the fast setting.
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1. Close the drain valve.

2. Fill with autoclave with approximately 5.5 liters distilled water and 0.5 liters tap water.

3. Load autoclave with items to be sterilized. Place autoclave tape on lids, if necessary, and be sure lids are on
loosely.

4. Close autoclave door. Be sure the door closes tightly. If not, adjust the screw below the door handle latch.

5. Set the exhaust selector to “Fast or Slow”, depending on the items being sterilized.

6. Set the time for 30 minutes.

7.  When the sterilization is complete, carefully open the door and drain valve. Do not open the autoclave

immediately after sterilization is complete due to the high heat and pressure; allow to cool and depressurize.

6.4 BALANCES

6.4.1  Laboratory balances will be calibrated and verified by af outside company once a year.
6.5 MAINTENANCE OF THE QIAGEN EZ1s

Each month the piercing units will be cleaned and the @-ringsigreased on the Qiagen EZ1 robots. Maintenance
actions will be recorded on the Qiagen EZ1 Maintefiance Worksheet. A volume test will be conducted every six
months to monitor the pipetting accuracy of the robots.) Results of the volume test are recorded on the
BioRobot EZ1 Volume Test Worksheet.

6.5.1 CLEANING THE PIERCING UNIT:

The piercing unit cleaning protocol can befaccessed using either the DNA Investigator Card or the Volume
Test Card. If only a cleaning isaequirédy use the DNA Investigator Card; if a volume test is also due, then use
the Volume Test card._This will limit the number of times the machine is turned on and off and cards are
switched. Never remove or insert a card when the machine is on. The DNA Investigator Card

should always be in the machine so that it ready for use.

1. With the robot off, insert the Volume Test Card or ensure that the DNA Investigator Card is in the card
slot.

2.  With the door closed, turn the machine on.

3. Press 1. Protocols.

4. Press 3. Clean piercing unit. The piercing unit will move forward and downward.
5. Open the door by lifting up, and clean the piercing unit with reagent alcohol.

6. Close the door and press Esc when finished.
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6.5.2  GREASING THE O-RINGS:

Apply a small amount of silicon grease to the top of a filter tip and use it to apply the grease to the tip adapters.

Wipe off any excess grease with a tissue.

6.5.3 VOLUME TEST:

The volume test requires the use of the Volume Test Card.

1.

10.

11.

With the machine turned off, insert the Volume Test Card.

For each robot to be tested, individually number and weigh six emptyelution tubes with caps. Record the
weight of the empty clution tubes on the BioRobot EZ1 Volume Test Waorksheet in the Qiagen EZ1
Maintenance Log.

Place the six empty elution tubes, without their caps, in row 1.

Place six sample tubes containing 1mL of distilled'water in row 4.

Place six tips in tip holders in row 2.

With the door closed, turn the machine on.

Press the Start button. The yolume testiwill begin.

When the test is complete], press Esc to exit the protocol and turn the machine off.
Remove the Volume Testi€ard and insert the DNA Investigator Card.

Replace the caps on the elution tubes and remove them from the machine.

Weigh each tube, now filled with approximately 500 uL of distilled water.

Record the weights of the water on the Volume Test Worksheet and calculate the variance. Allowable

variance is within 5% of the volume pipetted. For the 500uL pipetted in the volume test, the allowable range
is 474 to 525 pL. Recall that 500uL is equal to 500mg.

6.6 HAMILTON NIMBUS 4 MAINTENANCE
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The Nimbus requires routine maintenance to be performed daily, weekly, and semi-annually in order to ensure
optimal performance. Any maintenance failures should be reported to Hamilton Technical Support (1-800-648-
5950) for troubleshooting assistance.

Daily Maintenance:

The daily maintenance should be performed prior to the first run of the day. It is not necessary to perform the
daily maintenance prior to subsequent runs if it has already been performed on a given day. It is also not

necessary to perform the daily maintenance on days the Nimbus is not used.

1. Power on the Nimbus instrument and attached computer.
2. Open the Maintenance software (on the desktop).
3. Select the “Daily” maintenance type and click “Run Maintenance”,

4. Inspect deck and carriers for cleanliness.
a. Clean the deck with deionized water and/or ethanol.
b.  Wipe the o-rings on the channels with deionized waten
c.  Check the “Inspect deck and carriers for cleanliness” box.

5. Empty Tip Waste/Liquid Waste.
a. Remove the tip waste receptaclesand empty tips into trash.
b. Replace plastic trash bag in tip waste receptaele if needed.
c.  There is no liquid waste to empty.

d.  Check the “Empty Tip'Waste/Liquid Waste” box.
6. Sclect the “Check tightness of Pipetting Channels” box.
a. Read the message that appears, remove the tip eject plate, close the door, and click “Continue”.
b.  The system will automatically test the o-ring seals of the channels.
7. Select the “Check LLD” box.
a. Read the message that appears, ensure the tip eject plate is still removed and the door is still closed, and
click “Continue”.
b.  The system will automatically test liquid level sensing.
8. Click “OK” to acknowledge that the maintenance has completed successfully.

9. Replace the tip eject plate.

10. Click “Close”.

11. Exit the Maintenance software.
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Weekly Maintenance:

The weekly maintenance should be performed once a week regardless of whether or not the Nimbus is to be

used that week.

1. Power on the Nimbus instrument and attached computer.
2. Open the Maintenance software (on the desktop).
3. Select the “Weekly” maintenance type and click “Run Maintenance”.

4. Clean deck and carriers.
a. Clean the deck with deionized water and/or ethanol.
b. Check the “Clean deck and carriers” box.

5. Check condition of carriers and other devices.
a. Visually inspect the instrument for any obvious signs of damage:.
b. Clean the pedestals and racks with water and/ ot ethanol.
c. Check the “Check condition of carriers and otherdevices” box.

6. Empty and clean Tip Waste/Liquid Waste.

a. Remove the tip waste receptacle and empty tips into trash.
Replace plastic trash bag in tipdwvaste receptacle if needed.
There is no liquid waste to empty.
Clean the tip eject plate with deionized Wwater and/or ethanol.
Check the “Empty and clean Tip:Waste/Liquid Waste” box.

o oo o

7. Clean each channel: stop disk, o-ring, and tip eject sleeve.
a.  Wipe the pipettorichannelswith a kimwipe dampened with deionized water.
b.  Check the “Cleandeach’channel: stop disk, o-ring, and tip eject sleeve” box.

8. Clean the side covers
a. Clean the Nimbus enclosure with deionized water and/or ethanol.
b. Check the “Clean the side covers” box.

9. Select the “Check tightness of Pipette Channels” box.
a. Read the message that appears, remove the tip eject plate, close the door, and click “Continue”.
b.  The system will automatically test the o-ring seals of the channels.

10. Select the “Check cLLD” box.
a. Read the message that appears, ensure the tip eject plate is still removed and the door is still closed, and
click “Continue”.
b.  The system will automatically test liquid level sensing.

Forensic Biology Unit Policy Manual v07-01-2019 Page 46 of 81

/




-

Unit Policy Manual

11.

12.

13.

14.

Forensic Biology

Click “OK” to acknowledge that the maintenance has completed successtully.
Replace the tip eject plate.
Click “Close”.

Exit the Maintenance software.

Semi-Annual Maintenance:

At least once a year a service engineer from Hamilton will perform maintenance and calibration of the Nimbus.

REFERENCES:

Microlab® Nimbus Independent Channel Operator’s Manual. Hamilton®Robotics.

Microlab® Nimbus Enclosed Version Operator’s Manual. Hamilton Reboticst

Microlab® Nimbus Independent Channel Programmer’s Manual. Hamilton Robotics.

6.7 QIACUBE MAINTENANCE

6.7.1 MONTHLY MAINTENANCE

Clean the optical sensor, tip adaptempgripper unit, including the gripper, the stabilizing rod, and the spin
column lid holder, by carefully gviping these medules with a soft lint-free cloth moistened with water. To
gain access to the modules within the robatic arm:
a. Press “Tools” in théfhain menu.
b.  Select “Maintenance”/by pressing the up/down arrows to scroll through the list until it is
highlighted, and\thén press“Select”.
c.  Select “€leaning position” by pressing the up/down arrows to scroll through the list until it is
highlighted, and,then'press “Start”.
d. Follow theinstructions displayed in the touchscreen. You will be instructed to remove the waste
drawer and the labware tray.
The robotic arm will move forward and downwards, enabling the modules to be accessed for cleaning

through the opening for the waste drawer.

2. After cleaning the modules of the robotic arm, switch off the QiaCube at the power switch.

3. Thoroughly wipe the worktable with a soft lint-free cloth moistened with cleaning agent. Incubate as
appropriate, rinse with distilled water, and wipe dry with paper towels.

4. Clean the shaker rack, labware tray, heating adapter, and reagent bottle rack with cleaning agent. Incubate
as appropriate, rinse thoroughly with distilled water, and wipe dry with paper towels.

5. Clean the liner of the waste drawer with cleaning agent. Incubate as appropriate, rinse with distilled
water, and wipe dry with paper towels.
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6. Thoroughly wipe the inside and outside of the QiaCube using the cleaning agents.

Important: Do not use alcohol or alcohol-based disinfectants to decontaminate the QiaCube door.

Important: Take care that no liquid runs down the touchscreen. Liquid may be drawn through the dust
protection sealing by capillary forces and cause malfunction of the display. To clean the touchscreen, moisten a
soft lint-free cloth with 70% ethanol or a mild disinfectant and carefully wipe the display. Wipe dry with a

paper towel.
6.7.2 SEMI-ANNUAL MAINTENANCE

The centrifuge lid must be open to allow access to the inside of the centrifage. The lid should be opened only
after the centrifuge has come to a complete stop. If the lid does notfopen automatically, perform the following
steps.

1. Press “Tools” in the main menu.

2. Highlight “Maintenance” (scroll through the list byyusing thétup/down arrows), and press “Select”.

3. Highlight “Open lid” (scroll through the list bysgpressing the up/down arrows), and press “Select”.

Cleaning the rotor and buckets

1. Switch off the QIAcube atithe power switch.

2. Remove used disposable labware,sample tubes, and reagents from the worktable. Discard according to
your local safetyregulations.

3. Close the buffer bottles tightly, and store according to the instructions in the relevant kit handbook.
4. Remove all disposable rotor adapters, including tubes and spin columns, from the buckets.

5. Remove the buckets from the rotor. Undo the rotor nut on top of the rotor using the rotor key, and
carefully lift the rotor off the rotor shaft.

6. Submerge the rotor, buckets, and rotor nut in cleaning agent. Incubate as appropriate.
7. Rinse thoroughly with distilled water. Use a brush (i.e., a toothbrush or tube brush) to clean any parts
that are difficult to access, such as the bucket mount and the rotor head. Wipe surfaces dry with a soft lint-

free cloth. If available, dry the buckets and rotor with pressurized air.

Important: Make sure the paper towels and brush used are lint-free.
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Important: Make sure that all residual salt is removed.

Important: Make sure to remove all traces of cleaning agent from the centrifuge buckets. Residual agent
can cause the buckets to jam.

8. Apply a few drops of mineral oil (Anti-Corrosion Oil (rotor), cat. no. 9018543) on a soft, lint-free cloth,
and wipe the bucket mount and rotor claw. A thin, invisible oil film should cover the bucket mount and
rotor claw, but no droplets or smear should be apparent.

9. Apply oil to the rotor claw and to the bucket mount.

Important: Before applying oil to the rotor buckets on the rotor, make sure that the rotor and all buckets are

completely dry.
Cleaning the centrifuge

1. Moisten a soft lint-free cloth with cleaning agent, and clean the,inside ofthe centrifuge and the centrifuge
gasket. Incubate as appropriate.

2. Clean the inside of the centrifuge and the gasketiwith distilled water, and wipe dry with lint-free paper
towels. If available, use a vacuum cleaner.

Important: Make sure the gaskets remain in‘the proper pesitions.

3. Clean the centrifuge lid with a soft lint-free cloth moistened with cleaning agent. Incubate as appropriate,
clean with water, and wipe dry\with paper towels.

4. Check the centrifuge gasket for damage. If the gasket is damaged or shows signs of wear, contact QIAGEN
Technical Services.

Installing the centrifuge rotor and buckets

1. Mount the rotor. The rotor can be mounted in only one orientation. The pin on the rotor shaft fits into a
notch on the underside of the rotor directly underneath rotor position 1. Line up position 1 of the rotor
with the pin on the rotor shaft and carefully lower the rotor onto the shaft. Install the rotor nut on top of
the rotor and tighten using the rotor key supplied with the QIAcube. Make sure that the rotor is securely
seated.

2. Replace the rotor buckets. When replacing the rotor buckets, the side of the rotor bucket that must face
toward the rotor shaft is marked with a gray line. Hold the bucket at an angle with the gray line facing the
center of the rotor and hang the bucket on the rotor. Check that all buckets are properly suspended and
can swing freely.

Important: All centrifuge buckets must be mounted before starting a run.

Tightness Test
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The tightness test is performed to check whether the tightness of the pipetting system, including the attached
pipetting tip, is sufficient.

1. Load an empty 2 ml safe- lock microcentrifuge tube in position 1 of the shaker.

2. Fill areagent bottle with 96% ethanol and place in position 1 of the reagent bottle rack.

3. Load a tip rack of the filter tips you want to test (1000 I or 1000 ul wide-bore) onto the QIAcube.
4. Make sure that the QIAcube is switched on.

5. In the main menu, press “Tools”.

6. Select “Maintenance” by pressing the up/down buttons to scroll through the list until it is highlighted, and
then press “Select”.

7. Select “Tightness test” by pressing the up/down buttons o scroll'throughthe list until it is highlighted,
and then press “Select”.

8. Select the appropriate type of filter-tips (“1000 Mhtips” orsh000 Pl wide-bore tips”) by pressing the
up/down buttons to scroll through the list until it ishhighlighted, and then press “Select”.

9. Press “Start” to start the tightness test with thie seleeted type of filter-tips.

10. Follow the instructions displayed in the touchsereen, and press “Start” to start the tightness test. After the
load check, the robotic arm will pick up a tip, aspirate ethanol, and move to the tube. The tip will remain
in place above the tube for 2'minutes. The tip will be detached.

11. After the protocol is completed, open the QIAcube door and check if the tube contains liquid. If the tube
is still empty andidry, the tightness of the pipetting system is adequate. If you find liquid in the tube,

contact QIAGEN Technieal Services.

6.7.3 ANNUAL MAINTENANCE

A Qiagen Service Engineer will perform maintenance on an annual basis.

6.8 QIASYMPHONY MAINTENANCE
6.8.1 DAILY MAINTENANCE
After every day in which the QiaSymphony is run:
Tip Disposal Chute

1. Remove, clean, and rinse the tip disposal chute. Ensure it is dry before reinstalling.
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Liquid Waste Container

1. Remove and empty the liquid waste container into the waste barrel for EZ1 reagents.
2. Clean and rinse the liquid waste container.
3. Replace liquid waste container. Note: the liquid waste container can be autoclaved (121°C for 20min).

Drawers and lysis station

1. Remove all removable objects (tube/plate carriers, adapters, inserts, liquidwwaste station/tip park station,
tip disposal chute, liquid waste bottle) from the drawers.

2. Wipe the drawers and the removed objects as well as the lysisstation with ethanol-based disinfectant and
incubate as appropriate. Then wipe with a cloth moistened 4vith water and dry with paper towels. Return
the objects to the drawers.

3. Optional: Clean the removed objects by soaking them,in a glyoxal and quaternary ammonium salt based
disinfectant (e.g., Lysetol AF).

Important: There are spikes below the piercing deyicelin the “Reagents and Consumables” drawer that ensure
that the reagent cartridge is correctly positioned: Take care when cleaning the “Reagents and Consumables”

drawer.
Robotic Gripper

1. Wipe the robotic gripperawith a lint-free cloth moistened with ethanol-based disinfectant. Incubate as
appropriate. Impentant: Only wipe the weight. Do not wipe the rods otherwise the ball mechanism may
become jammed.

2. Wipe with a lint-frée cloth moistened with water and dry with paper towels.

WEEKLY MAINTENANCE

Drawers and Lysis Station

1. Remove tube/plate carriers, adapters, and inserts and soak them in disinfectant (e.g., Lysetol AF).
Incubate for at least 15 min, then rinse with water and dry with paper towels.
2. Check the condition of the bar code labels and make sure that they are not scratched.

Touch Screen
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Wipe the touch screen with ethanol-based disinfectant and incubate as appropriate. Then wipe with a cloth

moistened with water and dry with paper towels.
QiaSymphony Hood

Wipe the surface with a soft lint-free cloth moistened with deionized water. Then dry with a dry soft lintfree
cloth or paper towel. Important: Do not use ethanol-based disinfectant.

Pipetting System and Guards

1. Remove all 4 tip guards by pushing each tip guard upward until it clicks out of place and can be removed.
Soak in a glyoxal and quaternary ammonium salt based disinfectant (edg., Lysetol AF) for at least 15 min.

3. Rinse with water and wipe dry with paper towels. Make sure to replace the tip guards before operating
the instrument.

O-Ring Tightness Test
The tightness of the tip adapter O-ring should be checked weeklyand the O-ring must be changed monthly.

1. Inthe “Tools” screen, press “Service SP” or “Service AS”. Then select the service script
“CheckPipettingChannel ORing.lua”.

Press “Start” to start the tightness test.

3. Follow the instructions in the messages displayed on the touchscreen. When instructed to do so by the
software, place an empty tip-rack containing 4 test tips into the tip rack slot shown in the software
message (see picture on next page). Note: /Do not start an inventory scan during the protocol run. When
the inventory scan message appearsy press “No, nothing changed”.

4. If after running the tightness test for a particular tip adapter a message is displayed with “Failed”, the O-
ring must be changed. Tfone tip adapter fails the tightness test, we recommend changing all 4 O-rings at
the same time.

6.8.2 MONTHLY MAINTENANCE

Magnetic Head

1. Remove the cover from the magnetic head.

2. Wipe the exterior of the magnetic head with a lint-free cloth moistened with ethanol-based disinfectant
and incubate as appropriate.

3. Wipe with a lint-free cloth moistened with water and dry with paper towels.

Magnetic Head Guards

Check the magnetic-head guards. If required, clean before starting the next protocol run.

2. Open the “Maintenance” menu and run the service protocol “MH guard”. Gently raise the catches to
release the magnetic-head guards.

3. Wipe the magnetic-head guards with ethanol-based disinfectant and incubate as appropriate.
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4.  Wipe with a lint-free cloth moistened with water and wipe dry with paper towels. Replace the magnetic-
head guards.

5.  Open the “Maintenance” menu and run the service protocol “MH guard open”. Make sure to replace the
magnetic-head guards before operating the instrument.

Conveyer Base Tray

1. Carefully remove the conveyor base tray from below the magnetic head.
Soak in a glyoxal and quaternary ammonium salt based disinfectant (e.g., Lysetol AF) for at least 15 min.
3. Rinse with water and wipe dry with paper towels. Note: The tray can also be autoclaved at 121 °C for 20

min.
O-Ring Replacement
The O-rings must be changed every month using the “O-Ring Change Tool Set” (cat. no. 9019164).

Using the “O-Ring Change Tool Set” to perform O-ring change

Before removing the old O-ring, the new O-ring mustbe prepared. These steps should be performed for both
the QIAsymphony SP and the QIAsymphony AS instruments “Eer instructions, refer to the quick guide that is
included with the “O-Ring Change Tool Set” (cat.no. 9019164).

6.9 7500 SDS CALIBRATION / VERIFICATION PROCEDURES

The information for the procedures detailed in this section was taken from the Applied Biosystems
7300/7500/7500 fast real-Time PCR System Installation and Maintenance Guide. When the yearly calibration
checks are performed, the analyst performing the calibration must check the lamp usage and status. Procedure
6.8.7.1 details checking the lampdisageand status. The halogen lamp located in the 7500 SDS Instrument has a
life span of approximately 1,000 hours. If the lamp has exceeded 1,000 hours, or if a message is displayed that
recommends changing the lampyprocedure 6.8.7.2 should be followed.

6.9.1 BLOCK CONTAMINATION CHECK
Purpose: A check for contamination allows a user to determine if there are any areas of possible contamination
in the wells of the plate holder that would artificially increase the fluorescence in those wells during a run,

thereby increasing the quantitation result.

Preparing the Check This check is performed without a plate being positioned in the plate holder; therefore, if

there is a plate in the holder, remove it, and then close the carriage door over the sample block and lock it

down.

Note: This check is for information only and should not be saved using the 7500 System software during or

after the check. See step 3 below for instructions on documenting the contamination check.
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Performing the Check

1. Turn on the instrument and open the SDS software. Click File>New. In the new document wizard click
Finish to accept the default parameters.

2. Click on the “Instrument” drop-down menu and select “Calibration”. Click “Yes” to lower the block. In
the “Calibration” window select Filter A (FAM filter position), open the ROI Inspector and take an image
at 2048ms by selecting Snapshot.

3. Observe the background fluorescence in the 96 wells. Note any wells that have significant fluorescence;
fluorescence indicates contamination. For documentation, perform aSerceniShot (Alt + PrintScrn) and
then paste it (Ctrl-V) into a Microsoft Word blank document.

4. To determine an acceptable background fluorescence level:

Push the instrument carriage and allow it to spring back to‘opef it.

Put a new, clean, empty reaction plate without the cover intothe sample block.
Push the carriage forward to close it.

a0 oe

Take another image at 2048 ms. For documetitation, perform a Screen Shot (Alt +PrintScrn) and
then paste it (Ctrl-V) into a Microsoft Weérd blank document.
e. Save as Calibration Contamination check (MM/DDZYY) in the appropriate instrument folder.

5. If some of the wells still appear tohave significant fluorescence, clean them per the instructions in
“Cleaning the Sample Wells”.

Recheck the wells after cleaning, following steps 1 through 3 above.
6.9.2 7500 REGIONS OF INTEREST CALIBRATION

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit
2. ROI Calibration Plate (Part No. 4349415)

3. Centrifuge and vortex

Purpose:
A Regions of Interest (ROI) calibration maps the positions of the wells on the sample block so that the

software can associate increases in fluorescence during a run with specific wells of the plate. A calibration

image is needed for each well or filter to account for minor differences in the optical path.

Preparing the Plate
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Retrieve the ROI calibration plate from the spectral calibration kit from the freezer in the amplified DNA
room freezer. Allow the plate to thaw. Leave the optical film on the plate. (Do not discard the packaging as
the plate can be used up to three times). Vortex and centrifuge the thawed plate to assure that the liquid is in
the bottom of the plate wells.

Creating a Plate Document for the ROI Calibration

1. Start the instrument and open the SDS software. Load the ROI calibration plate into the plate holder
position.

2. Click File > New
In the New Document wizard or dialog box click Finish to accept thé default parameters. (The SDS

software automatically saves the ROI data to a set of calibration files on,the computer hard drive). Click
OK if any ROl error is displayed.

3. In the SDS software, select Instrument > Calibrate

4. In the ROl inspector dialog box that appears, right-clickithe black area of the window, then select
Display Properties.

5. In the Image Viewer Control Propertiésidialog Box:
a. Select Show Saturation
b. In the Sat Threshold field, énter 4000,
c. Click OK

6. In the ROI Inspectordialog box, set the lamp control:
a. Click Block up

b. Select Idlerom the Lamp Control drop-down list

Performing the ROI Calibration

1. In the ROl Inspector dialog box:
a. In the Exposure Time field, enter 2048 for the 7500 and
b. Select Filter A.

2. Click Snapshot to generate an ROI image.

3. Determine if your ROI image is acceptable. An acceptable image will not have saturated red areas in any
wells. (A few red pixels in a well are acceptable).

If the ROI image appears over saturated, continue to reduce the number in the Exposure Time Field
(2048) by half until an acceptable image is obtained. Once the acceptable image is produced, print this
screen by pressing Alt + PrintScrn and then Ctrl V into a Microsoft Word blank document.
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4. If your image is acceptable, Click Generate Calibration.
The software takes a snapshot, and then displays a message dialog box or an ROl image. A successful

calibration will have green circles around all wells.

If the calibration image is not successful, see pg 45 for of the 7500 Installation and Maintenance Guide for trouble

shooting.

5. Click Save Calibration to save the image for filter A. (An OK will appear in the dia]og box for Filter
A). Remember to Save after every filter.

6. Repeats steps 1 through 6 for the remaining filters: Filters B, C, D and E. Reset the Exposure Time to
2048 before performing the calibration for each filter.

7. Click Done > File > Close and click NO to save the platé docunient.

Unloading the Plate

In the ROI Inspector dialog box, click Block Down anditemove the plate. Return the plate to the packaging if

not pcrforming background and optical calibration.

6.9.3 Performing the Background'Calibration on the 7500 SDS Instrument

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time"PCR-System Spectral Calibration Kit
2. Background Plate (Part,No. 4330124)
3. Centrifuge and vortex

Purpose A background calibration measures the level of background fluorescence in the instrument. The run
will perform continuous reads of a background plate containing PCR buffer for 10 minutes at 60°C and
average the spectral results to a calibration file. The software can then use the file to remove the background

fluorescence from the run data.
Perform a background calibration after replacing the lamp or monthly, depending on instrument usage.

Precautions Since the signal consists of fluorescence from several sources it is important to use gloves when

handling the plate, use a clean centrifuge and vortex, and do not place the plates on the lab bench.
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Preparing the Background Calibration Plate Retrieve the prepared background plate from the spectral

calibration kit from the freezer in the amplified DNA room. Allow the plate to thaw (Do not discard the
packaging as the plate can be used up to three times). Vortex and centrifuge the thawed plate to ensure that
the liquid is in the bottom of the plate wells.

Creating a Plate Document for the Background Calibration

1. Place the prepared plate into the plate holder and close the tray/door. Start the instrument and open the
SDS software. Click File > New.

2. Configure the New Document Dialog box:
a. Select Assay >Background.
Select Container > 96-Well Clear.
Select Template > Blank Document
In the Operator field, enter a name.
In the plate Name field, enter : Background_<date MMDDYY> and click Finish.

o o o

3. In the SDS software select File > Save As. On 7500,#1, navigate to C:\SDS1.2\Documents and save.
On 7500 #2, navigate to D\: > SDS 1.2 >SDS Documentsiand save. Select Save as type > SDS
Documents (*.sds).

Performing the Background Calibration In the\SDS software: Select the Instrument tab and click Start. The
instrument begins the calibration runfafter the heated cover comes to temperature.  After the run is complete,

click OK. The background run may take 10 minutes.

Analyzing the BackgroundCalibration Data

1. Click the green arrow or select Analysis > Extract Background. The software extracts the
background signal then displays Background Extraction Complete. Click OK.

If the message indicates the image exposure is too low, see pg 56 of the 7500 Installation and Maintenance Guide for

trouble shooting.

2. In the plate document, select the Results tab, then Spectra tab. Print this page for the Background
Calibration records and to show that the instrument is free of significant contaminants.

3. Inspect the raw data for irregular spectral peaks that exceed the following fluorescent standard units

(FSU). All wells should be selected.

Filter FSU
A,B,C,D >72,000
(7000/7500)
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E (7500) >90,000

If the fluorescence exceeds the FSU indicated, see pg 64 of the 7500 Installation and Maintenance Guide for trouble

shooting.

If a contaminant is observed (high fluorescent data), see pg 108 of the 7500 Installation and Maintenance Guide for

c]eaning contaminants.

4. Inspect the background plate image for bright areas of fluorescence and perform a Screen Shot (Alt +
PrintScrn) and then paste it (Ctrl-V) into a Microsoft Word blank document for documentation.

5. Select File > Close
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6.9.4 PERFORMING THE OPTICAL CALIBRATION FOR THE 7500 SDS INSTRUMENT

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit
2. ROI Calibration Plate (Part No. 4349415)
3. Centrifuge and vortex

Purpose: The optical calibration compensates for the physical effects of the additional filter present in the

7500 instrument and needs to be performed after every 7500 system background calibration.

Preparing the Optical Calibration Plate

Retrieve the prepared ROI plate from the spectral calibration kit fromdthe freezer in the amplified DNA room.

Allow the plate to thaw (Do not discard the packaging as the plate can be used up to three times). Vortex and
centrifuge the thawed plate to ensure that the liquid is jn the bottom of'the plate wells.

Creating a Plate Document for the Optical Calibration

1. Start the instrument and open the SDS software. Load the ROI calibration plate into the plate holder
position.

2. Click File>New.

3. Configure the New DocuméntDialog box:

a. Select Assay >Calibration.
Select Container,> 96=Well Clear.
Select Template > Blank Document
In the Operator field, enter a name.

o a0 o

In the plate Name field, enter :
Calibration_<date MMDDYY> and click Finish.

4. In the SDS software select File > Save As. On 7500 #1, navigate to C:\SDS1.2\Documents and save.
On 7500 #2, navigate to D\: > SDS 1.2 >SDS Documents and save.

Performing the Optical Calibration
In the SDS software: Select the Instrument tab and click Start. The instrument begins the calibration

run (10 min.) after the heated cover comes to temperature. After the run is complete, click OK.

Analyzing the Optical Calibration Data

Click the green arrow or select Analysis > Extract. The software extracts the optical calibration then

displays a message indicating the extraction is complete. Click OK.
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Click on the Results and Spectral Tabs. Select all wells and print this screen. Inspect the raw background

data for any irregular spectral peaks.
For any error messages, see pg 64 of the 7500 Installation and Maintenance Guide for trouble shooting

Click File>Close.

6.9.5 PERFORMING THE PURE DYE CALIBRATION ON THE 7500 SDS INSTRUMENT

MATERIALS REQUIRED:

1. Applied Biosystems 7500 Real-Time PCR Systems Spectral Calibration Kit I
(PN 4349180 containing Pure Dye Plates FAM, JOE, NED, ROX,SYBR Green, TAMRA, and VIC).

2. Centrifuge and vortex

Purpose During a pure dye calibration run, the system collegts spectral data from a series of pure dye
standards and stores the spectral information for the pure dye standards in the pure spectra run file, a

calibration file in the SDS directory.

The software then uses the pure spectra’data during subsequent runs to characterize pure dyes and distinguish

the individual contribution of each dye in the gollective fluorescence collected by the instrument during a run.

Important! Before performing a pure dye calibration, you must perform an ROI calibration, a background

calibration, and an optical calibration:

Preparing the Plate Retricy@the pure dye plates from the spectral calibration kits from the freezer in the
amplified DNA room | Allow the plates to thaw (~5 minutes). NOTE: Do not remove a pure dye plate
from its packaging until it is ready to be used. The fluorescent dye in the wells of each pure
dye plate is photosensitive. (Do not discard the packaging as the plates can be used multiple times).
Leave the optical film on the plates. Although multiple pure dye plates are in Spectral Calibration Kit I, only
the plates that are currently used for the quantitation chemistry being employed need to be run. For
Quantifiler and Quantifiler Duo, only FAM, VIC, ROX, and NED need to be run.

Creating a Plate Document for the Pure Dye Calibration

1. Start the instrument and open the SDS software. Click File > New.

2. In the New Document Wizard dialog box:
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Select Assay > Pure Spectra.

Select Container > 96-Well Clear.

Select Template > Blank Document.

In the Operator field, enter your initials.

In the Comments field, enter the plate bar code number.

e a0 oe

Click Finish. Note: It is not necessary to name or save the pure dye plate document. The SDS
software automatically saves the pure dye data to a calibration file on the computer hard drive.

Selecting the Dye
In the Pure Spectra Calibration Manager dialog box:

In the Dye List field, select a pure dye to calibrate.
Click Calibrate.
If you are prompted to disconnect the plate document, click Yes.

oo o w

A message prompts you to load the plate. Do not click Yes or No atthis point.

Preparing and Loading a Pure Dve Plate

1. Remove the appropriate Pure Dye plate fromiits packaging. Do not discard the packaging as the plate can

be used multiple times. Leave the optical film omthe plate.

2. Vortex and centrifuge the thawed plate to,assure thatthe liquid is in the bottom of the plate wells.

3. Verify that the pure dye plate that/§oware about to load matches the dye selected in the Pure Spectra
Calibration Manager.

4. Load the plate in the instrument with the notch in the upper right corner.

Performing the Pure Dye{Calibration

1. In the dialog box that prompts you to load the plate click Yes. The run takes ~5 minutes to complete.

2. When the SDS software completes the run, remove the pure dye plate from the SDS Instrument, place it

back into its packaging, and place it back into its respective spectral calibration kit in the freezer.
Calibrating remaining dyes:

. Click Next Dye >.
2. Repeat the procedures in Preparing and Loading a Pure Dye Plate and Performing the Pure Dye
Calibration to run the remaining pure dye plates.

3. After you calibrate the instrument with all pure dyes provided in the spectral calibration kits, click
Finish.

Analyzing the Pure Dye Calibration Data
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When each pure dye plate is run, the SDS Software automatically creates and saves a plate document for each
dye. After you calibrate all of the pure dye plates, the plate documents remain open behind the plate

document displayed by the software. To complete the calibration, analyze all open pure dye documents:

From the Windows menu, select the plate document to analyze.
Select the Results tab, then select the Spectra tab.
Select all wells of the plate document by clicking the upper-left corner of the plate grid.

B w N =

Click the green arrow (or select Analysis > Extract Pure Spectra). The SDS Software completes the
extraction, then displays a message:

If the software displays: Do this:

Pure Spectra Extraction Complete — The analysis Click OK, then gafto step)5.

is successful. Important! The pure dye
calibration is not complete at this
point.{Beforglclosing the plate document
you must inspect the Spectra plot as

explained in steps 5 through 8 below.

Repair Message—“The following wells require Clidk, OK, then go to step 5.

. »
rcpalr e

(For information on how the software
autosrepairs calibration spectra, see
“About Pure Dye Spectra” on pg 79 of the
Applied Biosystems 7300/7500/7500 Fast
Real-Time PCR System Installation and

Maintenance Guide.

Error Message—“Pure Spectfa Extraction Click OK, load the plate, then run the
Detected an Unknewn Error, . .” pure dye plate again.
If the calibration continues to fail, perform

the calibration with a new pure dye plate.

5. In the pure dye plate document:

a. Select the Results tab.
b. Select the Spectra tab.

6. Select all wells of the plate document by clicking the upper-left corner of the plate grid.

7. Using the tables below as a reference, verify that the peak for the spectrum of the pure dye occurs at the
correct filter. For documentation, Print the spectra for each dye (Alt + Print Scrn; then open a new

blank Microsoft Word document and Ctrl V to paste the spectra). If the peak for the spectra of a dye
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occurs in the wrong filter, you may have run the wrong dye plate during the calibration. Repeat the

procedure using the correct dye.

Instrument Pure Dye Filter I Peak (nm)
7500 System FAM | A | -s200m |
vIiC B ~550nm | = =
NED c 580 .~ © - .
.
| 9
ox @ b W -6omm | = o e
i |

8. Select File > Close. Important! Do not close a plate document until you have extracted it. During
the calibration, the software creates plate documents for each pure dye plate as it was run. You must

extract each one individually before closing it.

9. Repeat steps 1 through 8 to extract the calibration data for the remaining pure dyes.

6.9.6 Running the TagMan RNase P Plate Data on the ABI 7500 SDS

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit
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2. TagMan RNase P Instrument Verification Plate (Part No. 4350584)
3. Centrifuge and vortex

Purpose The TagMan RNase P Instrument Verification Plate run verifies the performance of an Applied
Biosystems 7500 SDS instrument. The RNase P plate is pre-loaded with the reagents necessary for the

detection and quantification of genomic copies of the human RNase P gene.

The RNase P plate contains five replicate groups of standards, two unknown populations and four no template

control wells. After the run, the SDS software will assess the instrument performance.

Preparing the TagMan RNase P Plate Retrieve a prepared TagMan RNasé P Verification Plate kit from the

freezer in the amplified DNA room and allow the plate to thaw (appreximately 5 minutes). Vortex and
centrifuge the thawed plate to ensure that the liquid is in the bottem of the plateavells. If the RNase P plate

has a compression pad on it, remove it from the plate.

Creating a Plate Document for the RNase P VerificatiofitRun

1. Start the instrument and put the RNase P plateiin thelinstrument.
2. Open the SDS software and click File >New.

3. In the New Document Dialog box:
a. Sclect Assay >Absolute Quantification (standard curve).
Select Container™ 96-Well Clear.
Select Template > AQ RNase P Install
In the Operator field, enter a name for the RNase P plate (i.e. RNase P MMDDYY) click Finish
In the SDS'software, scléet File> Save As. (Navigate to D\:>AppliedBiosystems>SDS Documents

o a0 T

and Save)

Performing the Verification Run In the SDS software: Select the Instrument tab and click Start. (The

instrument default parameters should be correct. The RNase P plate volume is 50ul). The instrument begins

the run which lasts approximately 1.5 hours. After the run is complete, click OK.

Analyzing the TagMan RNase P Plate Data

1. Select Analysis > Analysis Settings. Select Auto C, >Click OK. Click the green arrow or select
Analyze.

2. Assess the results. In the plate document: Select the Results tab then select the Amplification Plot
tab.
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4. Display the data: from the Amplification Plot tab:
a.  Click the upper-left corner of the plate grid to select all wells.
b. Select Data > C, vs. Well Position to display the plots. Save this data.
5. Verify the uniformity of cach replicate population by comparing the groupings of C, values.

If outliers are present, omit and reanalyze (see page 93 of the 7500 Installation and Maintenance Guide for

trouble shooting, this will apply to the 7000, as well).

6. In the results tab, select the Standard Curve tab and verify that the R” value is > 0.990. Save and print
this data.

7. In the Report tab, calculate the verification value of the'5,000-copy and 10,000-copy populations:

a.  For the 5,000-copy populations, in the Report tabyscroll to a sample in the 5K population. Apply the
value in the Mean Qty and StdDev Qty columns to thefollowing equation:

5K value = MeamQty + 3(StdDev Qty)

b.  For the 10,000-copy populations, in the Report tab, scroll to a sample in the 10K population. Apply
the value in the Mean Qty and StdDey Qty columns to the following equation:

LOK value = Mean Qty — 3(StdDev Qty)

8. Compare theyalues,of the 30K and 5K-copy populations. If the 10K value is greater than the 5K value
the 7500 has passed.

9. With all wells chosen, print the Report. Save the Tabular Report Data and the Standard. You may
discard the Raw Data and the Delta Rn vs Cycle Data pages. It is recommended that the calculations
performed above be written on one of the Tabular Report Data pages.

10. Close Program. If asked to Save, click “yes”.
Remove the plate and discard. (Note: the plate cannot be re-used)
6.9.7 Monitoring and Replacing the Lamp on the 7500 SDS Instrument

6.9.7.1 Monitoring the Lamp Status
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The halogen lamp located in the 7500 SDS Instrument has a life span of approximately 1,000 hours. If the
lamp has exceeded 1,000 hours, or if a message is displayed that recommends changing the lamp,

procedure 6.8.7.2 should be followed.
1. Select File > New.
2. In the New Document Wizard, click Finish.

In the SDS Software, select Instrument>Lamp Status/Replacement. In the Lamp
Status/Replacement dialog box, the usage hours and lamp current are displayed. The Condition field
will indicate one of the following:

Good—the lamp is functioning well. There is no need to replacethe lamp bulb at this time. Click
Close.

Failed—The lamp bulb must be replaced. Click Close; thenfreplace the lamp.

Change Soon—the lamp bulb usage is above 2000 hours. Itds,recommended to replace the lamp

soon. Click Close, then replace the lamp.

Warning messages may be displayed before or'during @xun that indicate low lamp current. See page 121 of the

Installation and Maintenance Guidefor these messages, what they are describing, and how to proceed.

6.9.7.2  Replacing the Halogen Lamp on the 7500 SDS Instrument

The halogen lamp locateddmithe 7500 SDS Instrument has a life span of approximately 1,000 hours. If the
lamp has exceeded 1,000 hours, or if a message is displayed that recommends changing the lamp, this

procedure should be followed.

MATERIALS REQUIRED:

1. Halogen bulb (12V, 75W)
2. Small pointed object, for example a screwdriver.
Important: Wear powder-free gloves when you handle the lamp.

1. Power off, then unplug the 7500 SDS Instrument. Allow the instrument to cool for 15 minutes.

2. Open the access door to the Instrument:
Insert a thin screwdriver or other object into the keyhole on the edge of the front access door, then push

to unlatch the door. Open the door.
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3. Remove the lamp from the instrument:
Slide the lamp release lever downward. Firmly grasp the lamp and lift it up and out of the slotted mount.

4. Inspect the lamp for signs of failure (see the Installation and Maintenance Guide page 124 for
indications of lamp failure).

5. Place the new lamp into the instrument

Slide the lamp release lever upward. Firmly grasp the lamp, place it into the slotted mount, then carefully

slide the lamp downward into place.

6. Close the access door.
7. Plug in and power on the 7500 SDS Instrument.
8. Open the 7500 System software program.
If the Quick Startup document dialog box is not opén, seleét File ' New. In the New Document

wizard, click Finish. In the SDS software, select Instrument®> Lamp Status/Replacement and

click on Reset lamp timer then close.

9. Inthe ROl Inspector dialog box, select Lamp Control > Idle.

10. While the instrument is runningglook through the grating of the access door and verify that the lamp
is illuminated, then click Done.

Important! After replaéing the lamp, the following calibrations must be performed: ROI Calibration,
Background and©ptical{Calibrations, Pure Dye Calibration, Instrument Performance Verification
(RNase P Plate).
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6.10 PROCEDURE FOR THE CALIBRATION CHECKS OF THE THERMOCYCLERS

The thermal cyclers used for the polymerase chain reaction amplification of DNA are located in the
Amplification Room of the Forensic Biology Unit. A calibration verification test and temperature non-
uniformity test are conducted on each thermal cycler approximately every six months. The verifications are
conducted by an outside vendor.

6.11 3500 Maintenance

OVERVIEW OF 3500 MAINTENANCE SCHEDULE:

Weekly/Biweekly (recommended in the following order):

Run the Wash Pump and Channels Wizard (weekly)

Clean anode buffer cup pin-valve assembly (weekly)

Place new Anode Buffer Container on instrument (Hard Stop) (bi-weckly)
Replace Cathode Buffer Container (Hard Stop) (bi-weekly)

Restart computer and instrument (weekly)

Monthly:

Flush the Pump Trap

Replace septa on Cathode Buffer Contaifier
Clean the autosampler and drip tray
Defragment Hard drives

As needed:

Replace Polymer

Spatial Calibration

Spectral Calibration

Replace Capillary Axfay (also requires spatial and spectral)

Pump cleaning
Powering on the 3500 and launching the Data Collection software
1. Power on the computer. At the Log On prompt, log in to the computer.

2. Before turning on the 3500 instrument, ensure that the oven door is closed and locked, that the

instrument doors are closed, and the computer is powered on.

3. Power on the instrument by pressing the on/ off button on the front of the instrument. Ensure that the

green status light is on and not ﬂashing before proceeding.
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4. Click on the 3500 Series Data Collection Software 2 icon on the desktop. Log in to the data

collection software with the password taped to the monitor.

5. Use the Dashboard to review maintenance notifications. When you complete a task, click the green

check mark to indicate that it was completed, or the red X to mark it as dismissed.

6. Click on Maintenance on the top panel. Use the left panel to navigate to the schedule calendar or

Maintenance Wizards to complete the needed maintenance.

Weekly Maintenance

At least 30 minutes prior to beginning weckly maintenance, bring Cénditioning Reagent, POP-4
Polymer*, Anode buffer container, and Cathode Buffer Containef to equilibrate’'to room temperature.
*If polymer remains before the expiration date, and there argfstill injéctions léft in the pouch, polymer can

be reused for a total of approximately four weeks on the instrument before it needs to be replaced.
Run the Wash Pump and Channels Wizard

This wizard takes about 40 minutes from start to)finish.\Click ‘Maintenance’ on the top panel, and

‘Maintenance Wizards’ on the left to/find the “Wash Pump and Channels’ wizard.

Dashboard | Edit * Library Maintenance Tools * Manage ¥ Preferences Help * LogOut
P € V 2
Maintanance
A applied " . 2 —
® biosystems™
| Camrate | ‘Which maintenance task would you like to perform?
Spatisl
%m.‘l
Fill
Performanca Check
[ HSTA ill 1LY
Sequencing Install Standard INSTALL & capillary array ). FILL the array wath frash pohymes

Fragmentinstal Standad

HID Install Standasd

- Wizarnds:

Planned Mantenance
Remave
Notficatons Log Bubbles REMOVE bubbles ram the pofymer pump Pekirrid REPLENISH the palymer installad an tha instument
Servicelag

Schedule

Change
Polymer CHANGE the typs of polymer installed on the instrumert

WASHthe pump chamber an Type with the option 1o change areys

Shutdown

o SHUTDOWN the instrument

Instrument
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Follow the wizard prompts to empty the anode buffer (NOTE: The EMPTY anode buffer container is placed
back on the instrument for the water wash), remove polymer, insert conditioning reagent, and insert
polymer to flush the pump chamber and channels.

Clean anode buffer container valve pin assembly

Following pump chamber and channels wash, and before installing the new anode buffer container, use a
clean lint-free cloth and deionized water to wipe clean the anode buffer container valve pin assembly on the
polymer delivery pump.

Place new Anode Buffer Container on instrument

1. Remove Anode Buffer Container from outer plastic wrap. Ideally, this is done after the wash pump and

channels wizard.

2. Tilt it slightly to make sure that most of the buffer is in the larger side of the container. There should be
less than 1 mL of buffer remaining in the small sidéwof the'container. Verify that buffer is to the fill line.

3. Gently peel off the plastic seal on the top without spilling any into the small side of the container. If it
does spill into the overfill side, pipette,it back into the reservoir so that the liquid reaches the fill line.

4. Place the Anode Buffer Contdiner (labelsidefirst) under the valve pin assembly, and slowly slide the lip

of the container into the locks.
Replace Cathode Buffer Container (replacing septa only once per month)

1. Remove Cathode Buffer Container from outer plastic wrap and peel off plastic seal from the top,

ensuring that it is pecled off of every circular opening.
2. Wipe off any buffer on top of the container with a lint-free cloth. Ensure that the top of it is dry.

3. Press tray on the front of the instrument to bring the autosampler forward. Remove the old cathode

buffer by pinching in the middle.

4. Place the appropriate cathode buffer septa on both sides of the cathode buffer container. These only
need to be replaced once per month. Septa can be washed with water and returned to the new cathode

buffer.

5. Install the new buffer by clickjng it into the tabs on the autosampler.
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6. Close the instrument door to re-initialize.

Restart computer and instrument

1. Close data collection software.

2. Shut down computer.

3. Once computer is shut down, press the power button on the instrument.
4. Restart computer, but don’t log in.

5. Once the computer is on, turn the 3500 back on by pressing the power again. Let the instrument

initialize and wait for the solid green light to appear before logging'on to the computer.
6. Click on the 3500 Series Data Collection Software 2,icon on.the desktop. Log in to the data
collection software (it may take a minute for the eénnections to be reestablished before the software can

open).

Monthly Maintenance

Flush the Pump Trap

The water trap must be flushed onceperfimonth (or more often as needed) to prolong the life of the pump

by cleaning any diluted polymeriand,clearing air bubbles.

1. Fill the supplied 20imlL, all*plastic Luer lock syringe with nanopure water. Do not use a syringe smaller
than 20 mL. Doing so may generate excessive pressure within the trap. Expel any bubbles from the

syringe .

2. Attach the syringe to the forward—facing Luer fitting at the top of the pump block. Hold the fitting with
one hand while threading the syringe onto the fitting with the other hand.

3. Open the Luer fitting by grasping the body of the fitting and turning it to loosen. Attached syringe and

turn counterclockwise approximately one half turn.

IMPORTANT! Do not use excessive force when you push the syringe plunger as this may damage the trap
seals. Take approximately 30 seconds to flush 5 mL of nanopure water through the trap.
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4. Remove the syringe from the Luer fitting. Hold the fitting with one hand while turning the syringe

counterclockwise with the other hand.
5. Close the Luer fitting by lightly turning clockwise until the fitting seals against the block.
6. Dispose the excess water inside the overflow container.
Replace septa on Cathode Buffer Container

Once per month, change both of the septa on the Cathode Buffer Container during the weekly

maintenance.

Clean the autosampler and drip tray

Wipe them down with a lint-free cloth and either deionizéd watef or absdlute ethanol

Defragment hard drives

Click the Windows Start icon to find Disk Defragmenter and open it. Click on each disk and click
‘Analyze’ to determine the degree of fragmentation. Click ‘Defragment’ for every disk that is

fragmented. This may take several minutes to hours depending on the degree of fragmentation.

As Needed Maintenance

Replace Polymer

If there isn’t sufficientpolymer to complete your run or if the polymer has exceeded 4 weeks use on the
instrument, it is neeéssary to place a new polymer pouch on the instrument. Get a new polymer pouch and
let it equilibrate to room temperature before replacing the old one. Use the Replenish Polymer wizard
to complete this. Follow the wizard prompts in order to flush the pump of the old polymer and refill the

capillaries with the new polymer. This wizard takes 10-20 minutes to complete

Spatial Calibration

The 3500 Series Data Collection software uses images collected during the spatial calibration to establish a
relationship between the signal emitted by each capillary and the position where that signal is detected by
the CCD camera. A spatial calibration is required to ensure correct alignment of the capillaries and optimal

detection of the signal in each capillary.

A new spatial calibration is recommended when:
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® A capillary array is installed, replaced or temporarily removed from the detection block
®  The instrument is moved

®  The detection cell door is opened

Perform Spatial Calibration and Evaluate Results

1. Click ‘Maintenance’ on the Dashboard. Click ‘Spatial’ under the Calibrate heading on the left.
2. Select No Fill, or select Fill to fill the array with polymer before starting the calibration.
3. Click ‘Start Calibration’. The display updates as the run progresses.

4. When the run is complete, evaluate the spatial calibration profile to ensurethat you see the following:
®  One sharp peak for each capillary. Small shoulders,may be acceptable.
®  One marker (+) at the apex of every peak. No off-apex madrkers.
®  An even peak profile (all peaks about theisame height).
®  The Max Spacing — Min Spacing shouldibe no mete than 2 pixels.

5. If the results meet the criteria above{ elick “Accept Results’.

Note: If any peaks are lower than usual for the istrument or the heights drastically slope up or down,

repeat the calibration with a fill. See below for an example of an acceptable Spatial Profile.

-500 - T T T .I - T l-. T T T T
] 100 200 300 400 coa
6. Click ‘View Spatial Calibration Report’.
Spectral Calibration
A spectral calibration creates a matrix that corrects for the overlapping fluorescence emission spectra of the
dyes. Although cach of these dyes emits its maximum fluorescence at a different wavelength, there is some
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overlap in the emission spectra between the dyes. The goal of multicomponent analysis is to effectively

correct for spectral overlap and minimize the presence of artifacts, such as spectral pull-up, in the data.

A new spectral calibration is recommended/required when:
®  The capillary array is changed (required) or temporarily removed from the detection block.
®  The instrument is moved.
®  The laser or CCD camera has been realigned/replaced by a service engineer.
®  Anincrease in (pull-up and/or pull-down peaks) is observed.
® A new dye set is used on the instrument.
®  The capillary array length or polymer type is changed.

®  The detection cell door is opened (not required by the séftware, butrecommended).

Perform Spectral Calibration and Evaluate Results

1. Pre-heat the oven by clicking ‘Start Pre-heat’.

Note: Preheating for approximately 30 minutes helps,mitigate'subtle first-run migration rate effects. The

pre-heat function automatically turns off after 2thours.

2. Click ‘Maintenance’ on the Dashboard. Click ‘Spectral’ under the Calibrate heading on the left

panel.
3. Check the pump asscifibly for bubbles‘and run the Remove Bubble wizard if needed.
4. Vortex the appropriate Matrix Standard. Prepare the Master Mix:
For GlobalFiler® and/Yfiler™ Plus analysis, use Dye Set J6.
a. Standard: 10 uL

b. HIDI Formamide: 290 uL

Note: Volumes other than above may be used to obtain spectral peaks between 3000-10,000 rfu. The total

volume should not exceed 300uL.
Note: After a capillary array is changed, a new spectral calibration must be run for each dye set.

5. Load 10 uL of matrix standard/HIDI mixture into wells A1-H1 of a 96-well reaction plate. Note:

multiple matrix samples (i.e., J6 or G5) can be run in subsequent columns on this plate if needed
P p q p
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6. Cover the plate with a 3500 septa mat and centrifuge to ensure that the samples are at the bottom of the

wells and place the reaction plate in the Veriti® thermal cycler.
7. Denature the samples by running the spectraldenature protocol on the 9700 (95°C, 5 min).

Note: The cover plate of the Veriti® thermal cycler may be closed onto the septa mat-covered reaction
plate, but do not clamp the cover down. Although the lid is not heated during the denature protocol, it

may stick to the septa mat and pull it up when the cover is opened if it is clamped down.

8. After the denaturation protocol is finished, chill the reaction plate immediately in the 96-well cooling

block (-20°C) for at least 3 minutes.

9. Place the plate into a 3500 Series 96-well plate base (it will only fit inione orientation) and cover with a
3500 Genetic Analyzer 96-well plate retainer. Check to ehsure that the¥étainer clip is properly seated.

10.Press the tray button on the front of the 3500 Genetic/Analyzer. Wheén the autosampler tray presents
itself, open the door of the instrument and place the tray onto the@ither position of the autosampler
(the tray will only fit in one orientation). Tilt the'plate toward the middle, first before lowering into the

side clip. Close the instrument door.

11.In the 3500 Series Data Collection Séftware 2, Click “‘Maintenance’ on the dashboard. Click
‘Spectral’ under the Calibrate heading on the left.

12.Select the number of wells (96), plate position, chemistry standard (Matrix Standard) and dye set (J6 or

G5). Select allow borfowing.

13.Click ‘Start Run’. Run takes ~30 minutes to complete. Passing capillaries are shown in green and
failing capillaries aréishown’in red. Borrowed capillaries are shown in yellow with an arrow indicating

the adjacent capillary from which results were borrowed.

14.Evaluate each capillary for the following:

®  Order of the peaks in the spectral profile from left to right:

J6: blue, green, yellow, red, purple, orange (an example is below)

®  Peak heights are sufficiently robust (>2,000 RFU) and do not contain extraneous peaks, gross
overlaps, dips, or irregular morphology. If peak heights exceed 20,000 RFU, set up another plate
with a reduced amount of matrix standard. If peak heights are below 2,000 RFU, set up another
plate with an increased amount of matrix standard. See below for an example of an acceptable J6

spectral profile. G5 is similar, but without the purple.
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15.1f the results meet the criteria above, click ‘Accept Results’. If the results do not meet the criteria, set

up another plate, adjustingamount of matrix standard, if necessary, and run again.
Installing or replacingthe capillary array
It is recommended that the capillary array be replaced after 160 injections per capillary, or removed from
the instrument for storage if the instrument is to be shut down for an extended period of time; however,
capillary life may be extended based on the quality of the data obtained from the array.

Select the ‘Install Array Wizard’ for guidance. This wizard takes 15-45 minutes to complete.

Note: A spatial calibration AND spectral calibration are required after a capillary array change. The

instrument will not run without a new spectral calibration associated with that capillary RFID tag.
Removing bubbles from the pump block
Periodically, check the pump chamber, channels and tubing for air bubbles. Press the button on the right

hand side of the front of the instrument to turn on the lamp inside the instrument. This will help locate any

air bubbles.
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Select the ‘Bubble Removal Wizard’ for guidance. This wizard takes 5-15 minutes to complete.
Pump Cleaning

In nearly all circumstances, the Water Wash Wizard is very effective in cleaning the pump assembly.
Occasionally, a situation in which the Water Wash Wizard is not sufficiently effective may arise. If polymer
has dried in the channels of the lower block, or if some contamination in the pump assembly is suspected,

use the Pump Cleaning Kit to thoroughly clean the pump assembly.
If this procedure is needed, refer to the Pump Cleaning Kit Protocol for83500,Series Analyzers.

REFERENCES:

Applied Biosystems 3500/3500xL Genetic Analyzer User Guide
Applied Biosystems 3500/3500xL Genetic Analyzer User(Bulletin
Product insert sheet from Dye Set J6 (Pub. Number 4426042 Rev. A)
Pump Cleaning Kit Protocol for 3500 Series Analyzers
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7.0 COLLECTION KITS AND SUPPLY ORDERING

7.1 PREPARATION OF EVIDENCE COLLECTION KITS

The Forensic Biology Unit provides officers, investigators, and sexual assault nurses with six types of kits used in

the collection of biological evidence.

In general, the Laboratory Technician is responsible for preparing and disseminating the kits, however, the unit
as a whole is responsible for these kits. A point person may be assigned the responsibility of these kits. A
minimum stock should be kept on hand at all times in order to fill requests promptly. Kit components should
also be prepared and kept on hand. Kits and kit components should be madefon a sterile surface. Use protective

gloves and a laboratory coat when preparing and handling kits and kit compenents.

7.1.1 REFERENCE MOUTH SWAB COLLECTION KITS

Keep 60-100 kits on hand at all times.

Place the following items in a Reference Mouth Sgxab Collection Kit envelope (a manila envelope with ‘SDPD
REFERENCE MOUTH SWAB COLLECTION KIT’ printed, on the front):

= 2 sterile, paper-wrapped swabs

® 1 small “SDPD Reference Mouth Swabs” ehvelope

® 1 smaller manila envelope

= 1 evidence seal

® 1 pair of large nitrile gloves

® 1 copy of ‘Instructions for the Collection of Reference Mouth Swabs’
® 1 copy of the SDPD ¢onsent form

Individual kits can be packaged together in large paper bags containing 20 kits.
7.1.2 BIOLOGICAL STAIN COLLECTION KIT

Keep 60-100 kits on hand at all times.

Place the following items in a Biological Stain Collection Kit envelope (a manila envelope with ‘BIOLOGICAL
STAIN EVIDENCE COLLECTION KIT’ printed on the front):

= 2 sterile, paper-wrapped swabs
® 1 tube containing sterile water
® 1 small ‘SDPD BIOLOGICAL EVIDENCE SAMPLE’ envelope

® 1 smaller manila envelope

\ Forensic Biology Unit Policy Manual v07-01-2019 Page 78 of 81




Unit Policy Manual

Forensic Biology

" 1 evidence seal
® 1 pair of large nitrile gloves

® 1 copy of ‘Instructions for the Collection of a Biological Stain’
7.1.3 VICTIM SEXUAL ASSAULT EXAMINATION KIT

Keep 60-80 kits on hand at all times.
Place the following items in a Victim San Diego Regional Sexual Assault Evidence Collection Kit envelope:

= 5 swube tubes

® 1 Pubic Hair Combings envelope with comb

® 1 Head Hair envelope with bindle

® 1 Left Fingernail Scrapings envelope with 2 fingernail swabs infa bindle

® 1 Right Fingernail Scrapings envelope with 2 fingernail swabs,in abindle

= 1 piece of tissue paper

= 1 evidence seal

® 1 victim label sheet (1 Cervical Swabs, 1 Vaginal,Swabsyl External Genital Swabs, 1 Oral swabs, 1 Rectal
Swabs sticker, 1 Left Breast Swabs, and 1 Right Breast Swabs'sticker)

7.1.4  SUSPECT SEXUAL ASSAULT EXAMINATION KIT

Keep 40-60 kits on hand at all times/
Place the following items in_a'Suspect San,Diégo Regional Sexual Assault Evidence Collection kit envelope:

= 5 swube tubes

® 1 Pubic Hair Combings envelope with comb

® 1 Head Hair envelope with bindle

® 1 Pubic Hair envelope with bindle

® 1 Left Finger scrapings envelope with 2 fingernail swabs in a bindle

® 1 Right Finger scrapings envelope with 2 fingernail swabs in a bindle

= 1 piece of tissue paper

® 1 evidence seal

® 1 suspect label sheet (1 Penile Swabs, 1 Scrotal Swabs, 1 Oral swabs, 1 Left hand fingers swab, and 1 right
hand fingers swab stickers)

7.1.5 PHYSIOLOGICAL SAMPLES KIT

Keep 60-80 kits on hand at all times.
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Place the following items in a Physiological Samples San Diego Regional Sexual Assault Evidence Collection

Kit envelope:

® 2 grey-capped blood vials (Vacutainer®) each in a cigar tube
® 1 urine bottle with sodium fluoride
® 1 custody seal

" 1 evidence seal

Blood vials and cigar tubes are provided by the Narcotics Unit.

7.1.6  FETAL TISSUE COLLECTION KIT

Prepared as needed.
Place the following items in a manila envelope:

® 2 blue-capped 50mL conical vials (1 is a spare)
®  Evidence seals
®  Procedure for collecting aborted fetal material

® 1 pair of large nitrile gloves

A cooler and ice pack will be provided to any investigators for transporting the fetal material to the Property
Room. Reference mouth swab.collection kits should also be provided to investigators for the purpose of

collecting samples from thedmother and alleged father.

7.2 ORDERING AND RECEIVING COMMERCIAL KITS
7.2.1 Ordering procedure

Requests for supplies, reagents, and DNA typing kits will be placed in the Supply Order Log (clectronic file)
located on the department network (G:\Laboratory\ Annaliese\Ordering, Quotes, POs\Ordering Log
AHD .xlsx).

When orders are placed, the date ordered and the order confirmation number will be logged into the Supply
Order Log.

7.2.2  Receiving supplies

The receipt of the supplies will be logged into the Supply Order Log. The packing slip received with the
supplies is initialed and dated then submitted to the Administrative Aide in charge of purchasing for the

laboratory.
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7.2.3  Receiving chemicals

The receipt of the chemicals will be logged into the Supply Order Log. The packing slip received with the
chemicals is initialed and dated then submitted to the Administrative Aide in Charge of purchasing for the

laboratory.

A record of the chemicals on hand in the Forensic Biology Unit will be maintained. Any new chemicals (i.e.

not previously ordered/received) will require an MSDS to be on file in the Unit.
Chemicals need to have the date and the initials of the receiver on the containér:

7.2.4  Receiving DNA kits

The kits used for DNA extraction, quantification, and typing mustiallbe recorded in the Kit Receipt Log upon
receipt. In general, the lot numbers of every component of the kit arg,reeorded as well as the lot number of
the kit. Kit components may be stored in different locdtions and, thus, all kits components must be labeled

with the laboratory-designated lot number (e.g., GF#YY).

7.2.4.1 QUANTIFILER KITS
Record lot numbers of the PCR reaction mixs/DNA standard, primer, and whole kit in the Kit Receipt Log.

The PCR reaction mix should be labeled with the whole kit lot number and stored in the reagent
refrigerator. The remainder of the kit (in the original box) will be stored in the reagent freezer. Place ‘Not
QC’d, Do Not Use’ stickens’omall kit,components. Replace with “QC OK” stickers once the quality control

tests have been completéd and reviewed.

7.2.4.2  STR TYPING KITS
Record lot numbers of all'eémponents of the kit and the whole kit lot number in the Kit Receipt Log. The

PCR reagents box should be labeled with the laboratory-designated lot number and stored in the reagent
refrigerator. The ladder will be labeled with the laboratory-designated lot number and stored in the reagent
freezer in the Amplification Room. Place ‘Not QC’d, Do Not Use’ stickers on all kit components. Replace

with “QC OK? stickers once the quality control tests have been completed and reviewed.

7.2.4.3  QIAGEN DNA INVESTIGATOR KITS (EZ1 or QiaSymphony)
Record lot numbers of all kit components, except the buffers and proteinase K, and the whole kit in the Kit

Receipt Log. Discard the proteinase K and buffers. Place ‘Not QC’d, Do Not Use’ stickers on all kits until
quality control testing has been completed. Replace with “QC OK” stickers once the quality control tests

have been completed and reviewed.
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